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Printing Threads 
There are two ways to print Threaded Discussions. You can print a "what you see is what you 
get" version of the thread in which you can "expand" select responses (or all responses) and then 
print exactly what displays on your screen, or you can print the "Print Friendly" version of the 
thread. The Print Friendly version prints the threaded discussion without all the links (like "Reply," 
"Edit," and "Email", for example) under each response. The Print Friendly option does include the 
Read/Unread status of each thread so you can quickly identify responses that have not 
been opened. 
 
To print exactly what displays in the Threaded Discussion interface: 

Step 1: Locate the threaded discussion you want to print.

Step 2: Click Expand All to "open" all the thread responses, or simply click 
the "+" sign next to the responses you want to see and therefore 
print. Only "expanded" responses will be printed. 

Step 3: Click Print in your browser. Whatever is displayed on your screen 
will print.  

 
To print the "Printer Friendly" version of the Thread: 

Step 1: Locate the threaded discussion you want to print.

Step 2: Click Show Options at the top of the Threaded Discussion. 
Step 3: From the options that display, click Printer Version. A Printer-

Friendly version of the Thread opens in a new browser window. 

Step 4: Click the Print button in the browser. 

 
 

Adding Third-party CoursePack Content Items 
The Third-party CoursePack content item allows you to link out to a third-party content site (like 
XanEdu, for example) and add existing or customized CoursePack material to your course. A 
CoursePack can include any number of things—full-text articles, case studies, video clips, literary 
works, explanatory notes, or even links to your own research materials on the web. When you 
adopt a CoursePack, you are granted a non-exclusive, non-transferable license to access and 
use the vendor’s online course material and curriculum services in your course.   
 
Currently, when you link out to the third-party site you can: 
 

 Create a CoursePack from scratch.  With this option, you can search for and compile 
all of the content in the CoursePack, such as articles, cases, and original literary works. 
 

 Select an existing CoursePack from the catalog. You can adopt a CoursePack as-is, 
or you can customize existing material and then adopt it. 

 
 Have a CoursePack created for you. You can have a custom CoursePack created for 

you based on your own personal syllabus or reading list. 
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As an instructor, access to view and adopt CoursePacks is free. Students, however, will be 
required to pay an access fee before they are allowed to view CoursePack content. The fee 
varies depending on the materials you include in the CoursePack.  
 
All in all, CoursePacks are a convenient and easy way to add content to your online course.  
 
When you add a third-party CoursePack to your course, you follow essentially the same steps as 
you would to add a Text or Multimedia content item:  
 

1. Add the Content Item shell to your course 
2. Add the content item to a unit 
3. Add actual content to the content item (in this case, associate a CoursePack with the 

content item) 
 
See below for more information about each of these steps. 
 

Adding a Coursepack content item 
You add a third-party CoursePack content item to your course just as you would add any other 
content item: 
 
To add a CoursePack content item: 

Step 1: Click the Author tab in the upper left corner of your screen.  
Step 2: In the left-hand navigation, click the unit to which you want to add 

the CoursePack. 

Step 3: Click Add Content Item at the top of the screen. 

Step 4: In the Add New Content Item field at the top of your screen, select 
XanEdu CoursePack from the Type: drop-down list. 

Step 5: If you’d like to call the CoursePack something other than “XanEdu 
CoursePack” in your course, enter a new name for the content item 
in the Name field. For example, you could call this content item 
something like “Required Readings.”  

Step 6: Assign the CoursePack to the entire class or to a group of students. 

Step 7: At this point, you can either:  

 Click Add to Course Home or Add to Unit (depending on 
where you're adding the CoursePack).  
 

 Click Add...and Create Dropbox Basket to add the 
CoursePack to the Course Home Page or to the unit you 
selected AND create a Dropbox basket for it. If you create a 
Dropbox basket for the Coursepack, students will be able to 
submit assignments related to the content item directly to 
the Dropbox basket for the CoursePack. See the Help topic 
Using the Dropbox for more information. 

 
Now that you’ve added the CoursePack content item to your course and to a specific unit, you 
need to associate an actual CoursePack with the content item. 
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Assigning a CoursePack 
Once you've added a CoursePack content item to your course, you need to associate an actual 
CoursePack or CoursePack material with that particular content item. That is, you need to go out 
and decide which readings, articles, video clips, etc. will be included in the Coursepack and 
therefore available to students. Remember that you can only associate one CoursePack per 
CoursePack content item. 
 
To assign a CoursePack: 

Step 1: In the navigation on the left side of your course, click the CoursePack content item you 
want to assign actual content to. 

Step 2: Click the Author tab in the upper left corner of the screen.

Step 3: Click Add/Edit CoursePack:  
 

 
 
Note: You’ll need to delete the default text that appears in the Visual/Text Editor in 
this screen (i.e., the “Note…:” text in the screen above). You’ll determine the Link Text 
for your CoursePack when you click Add/Edit CoursePack. Link Text always appears 
at the top of the CoursePack content item; however, you can add any additional 
information about the CoursePack at this point by entering it in the Visual/Text Editor. 
Link Text does not appear in the Visual Editor. 

Step 4: In the screen that appears, click Create or Edit XanEdu Coursepack.  
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Note:  This will take you to the XanEdu or third-party site, where you can create or adopt a 
CoursePack. Refer to the online Help on the site for all information about creating and 
adopting your CoursePack. 

Step 5: When you’re finished creating or customizing your CoursePack, click Adopt and 
follow the instructions on-screen. When the adoption process is finished, close the 
third-party window and return to your course.  

Step 6: Select the CoursePack you just adopted from either your Personal Library or from the 
Course Library. Your Personal Library contains CoursePacks that YOU have created.   
The Course Library contains CoursePacks that have been added to the course by any 
user. Since you added the CoursePack to the course, you should be able to see the 
CoursePack in either library.  
 

Step 7: Enter Link text for the CoursePack. This is the text students will see and click on to 
view the CoursePack materials.  

Step 8: Click Add CoursePack to assign the CoursePack materials to the content item.  
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Editing or deleting a Coursepack 
You CAN edit or delete a CoursePack that you’ve added to your course. However, we suggest 
you do this with caution. If you delete a CoursePack that students have already purchased, 
students will no longer have access to the CoursePack. Similarly, if you change your mind and 
decide to associate a different CoursePack with a particular content item, students who already 
purchased access to the first CoursePack will have to re-purchase access to the new materials. 
You can, however, edit the link text that students click to access the course, and you can add 
additional explanatory text to go with the CoursePack.  
 
If possible, edit and/or delete CoursePacks BEFORE your students have access to your course.  
 
To edit a CoursePack:  
 

Step 1: Locate the CoursePack content item you want to edit in your course and click the 
Author tab.   

Step 2: Click the Add/Edit CoursePack link.  

Step 3: To edit the actual content within the Coursepack, click Create or Edit XanEdu 
Coursepack.  
 

 
 
This will take you to the XanEdu or third-party site, where you can edit and customize 
the CoursePack. Refer to the online Help on the site for all information about editing 
and adopting your CoursePack. Remember, however, that if you change the content, 
students who have already purchased the original CoursePack will have to re-
purchase. Changes you make may also affect the price of the CoursePack.  

Step 4: Re-adopt the CoursePack. When the adoption process is finished, close the third-party 
window and return to your course.  

Step 5: Select the CoursePack you just edited from either your Personal Library or from the 
Course Library.  
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Step 6: Click Add CoursePack to update the CoursePack within your course.  

 
 
To delete a Coursepack: 

Step 1: Locate the CoursePack content item you want to delete in your 
course and click the Author tab.  

Step 2: Click the Toolbox button in the top-right corner of your screen. 

Step 3: Click Delete [name of CoursePack]. Remember, if you delete a 
CoursePack that students have already purchased, students will no 
longer have access to the CoursePack.

 

Scheduling access to a CoursePack 
You can assign access dates and deadlines to any CoursePack. You can also choose to display 
these dates on your course calendar and on your students' calendars.  
 
To assign dates to a CoursePack content item: 

Step 1: Locate the CoursePack content item for which you want to schedule 
access and click the Author tab. 

Step 2: Click the Toolbox button in the top-right corner of your screen.  

Step 3: Click the Edit Schedule link. The Scheduler window opens. 

Step 4: Select whether you want the content item’s start and end dates to 
appear on the course calendar.  

• If you don't want these dates to appear on your students' 
course calendar, select Do not assign dates to this 
content item and then click Save Changes. The 
Scheduler closes.  

• If you do want the dates to appear, select Use dates below 
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to schedule this content item. Then enter a Start Date 
and an End Date in the appropriate fields. You can choose 
whether to allow students access to the content item before 
and after these dates by checking the Restrict access 
before/after this date checkboxes.  

Step 5: Click Save Change to close the Scheduler window. 

 
Note: You can set start and end dates for ALL your course units and course content items at one 
time from the Course Scheduler. See the help topic Scheduling Course Content for more 
information. 
 

Setting Content Item Preferences (Toolbox) 
Each content item you add to your course has a Toolbox associated with it. The Toolbox is a 
location where you can set preferences and properties for the current content item. Although 
most options in the Toolbox are common to all content items, there are several that may or may 
not display, depending on the content item. Options in the Toolbox may include:  

• Edit Schedule 
• View User Tracking  
• Move [content item]  
• Hide/Show [content item]  
• Delete [content item]  
• Create Dropbox Basket  
• Assign to Group(s) 

The Threaded Discussion content item includes two additional options, discussed at the end of 
this section. Additionally, the Toolbox options for Exams are specific to Exams only. See the Help 
section Adding Exams to your course for specific information on Exam Toolbox options. 
 
You can access the Toolbox for a specific content item by selecting the content item in Author 
mode and then clicking the Toolbox button in the top-right corner of your screen. 
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Note: You’ll only see the Assign To Groups option if you've created groups in your course. 
Similarly, you cannot create a Dropbox Basket for Exams or for Threaded Discussions, so you 
will not see the Create Dropbox Basket option for those items.  
 
Threaded Discussion options:  
 

 Set all topics to read-only status once the end date for the Thread is passed. This option 
lets you "lock" all thread postings once the content item's End Date is passed. Students 
can view the thread, but they will not see Respond or Edit buttons.  
 

 Allow students to edit their threaded discussion responses after posting them. This option 
allows students to edit their own thread responses after they've posted them to a 
Threaded Discussion. If a thread response is edited, a "Last Modified" date will display 
under the response, as well as the original post date.  

 
Note: Thread options you set in the Toolbox will apply to the current Thread only. You 
can set these same options at the course level from the Course Admin tab --> 
Preferences page. Options set at this level will apply to all Threaded Discussion content 
items in the course. You can still override course-level settings at the content item level, 
however.  
 

 
If your course uses Sharable Content Objects (SCO's), you can access the Toolbox 
associated with the SCO, but you will be unable to edit or otherwise modify the shared content 
object. As a result, in Author mode for a SCO content object only the Toolbox button is available. 
 

Moving Content  
Once you've added content items to your course, you may decide that you want them in a 
different order or that you want to move them to another unit. You can rearrange content items 
within a unit or between units.  
 
To rearrange content items within a unit: 

Step 1: Click the Author tab. 

Step 2: Click the unit in which you want to rearrange the content items. 

Step 3: Click Reorder Content Items. 
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Step 4: Change the numbers in the Order column to reflect the new 
content order.  
 

 
Step 5: Click Save Changes.

 
To move content items to another unit: 

Step 1: Click the Author tab. 

Step 2: Click the unit that contains the content item you'd like to move.  
Step 3: Click the individual content item you want to move. 

Step 4: Click the Toolbox button at the top of the screen. 

Step 5: In the Move/Reorder section of the Toolbox, click Move [content 
item name]. At this point, you can move the content item to another 
unit, or you can rearrange all the content items within the unit. 

  

 

Step 6: Move the content item to another unit by selecting the new unit from 
the drop-down list. Click Move Item. 

Step 7: You can reorder the content items within the unit by changing the 
numbers in the Order column to reflect the new content order. Make 
sure you click Save Changes.
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Hiding Content 
As an instructor, you can 'hide' (or unhide) a content item from the students' view. This option is 
useful, for example, if you want to use pop quizzes in your course, or if you want to incorporate 
an entire publisher test bank (hidden from students) that can be referenced in quizzes and tests 
throughout the course. You can hide or unhide a content item at any time.  
 
When you 'hide' a content item, the item does not display in the student view of the course 
navigation, the student view of the Gradebook, or in the Coursework area. Hidden content items 
display with an asterisk (*) to the left of the content item in the professor view.  
 
Tip: To minimize the number of content items in each unit, you can link students to hidden 
content items. For example, you could have a content item called Lecture and Lecture Part B. 
You could hide Lecture Part B, and then use the Content Connector (the Link Wizard in the Visual 
Editor) to link students to it from the Lecture content item. It looks like “paging” to the students, 
and they know exactly where to go next. 
 
 
To hide (or unhide) a content item: 

Step 1: Locate the Content Item within your course that you want to either hide or 
unhide. Remember that "hidden" content items are only "hidden" to students--
they are followed by an asterisk (*) in the professor view. 

Step 2: Click the Author tab.  
Step 3: Click the Toolbox button in the top-right corner of your screen.  
Step 4: Check the Hide [content item] checkbox to hide the selected item. If this box is 

already checked (i.e., the content item is already hidden), remove the check to 
unhide or "show" the item.  
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Using the Gradebook 
You and your students have access to a shared online Gradebook for your course. As the 
instructor, you will determine which course items appear in the Gradebook (i.e., which course 
items will be graded). You can assign point values to gradable items, as well as "weight" 
assignments relative to other course work if you choose. You can also create extra credit items or 
exclude graded items from the course grade. You will be responsible for entering students' actual 
grades (and any comments you may have) into the Gradebook. The Gradebook can then 
calculate and display up-to-date letter and numeric grades for each student, which you can also 
export to a regular spreadsheet application. Students can only view their own grades and work in 
the Gradebook. 
 
How it works...  
When you set up your Gradebook, you decide which items in your course will display in the 
Gradebook and which instances of those items will be "gradable." This is important because not 
all content items in your course will be assigned grades. For example, you may have created a 
Readings content item in your course. The Readings content item is not something students 
would be graded on per se. However, a Threaded Discussion revolving around the Readings 
section probably would be graded--and therefore included in the Gradebook. Similarly, you may 
have created two research paper assignments in your course--the first might be a "draft" or 
practice and the second might be the actual assignment. In this case, the first paper would not 
necessarily be graded, while the second probably would be. You can identify in the Gradebook 
which "instance" of each item should be graded.  
 

Note 
The Gradebook does include an "Exclude from Course Grade" option which allows you to 
essentially "grade" an assignment or provide feedback to students but not actually use the 
grade in the final course grade calculations. 

 
After you decide which course components you want to assign grades to, you can 1) assign 
specific point values to each course component that you've selected to be graded; and 2) 
"weight" each content item relative to other course content if you choose. Assigning points is 
optional; however, assigning total points possible values allows the Gradebook to calculate 
current student grades. You can assign points without using weighted percentages; however, you 
cannot use weighting without assigning points.  
 
Getting Started...  
There are really only three steps for setting up your Gradebook, and these steps correspond to 
the tabs across the top of your Setup Gradebook screen. Each tab builds upon the previous tab:  
 

•  Add New Items. This is where you decide which course items and course tools you 
want to appear in your Gradebook.  
 
•  Select Gradable Items. This is where you determine which "instance(s)" of the items 
you added to your Gradebook will actually be assigned grades.  
 
•  Assign Points/Weights. This is where you assign points possible (and relative 
weighted percentages if you choose) to the items you identified as gradable.  

 
The Setup section of your Gradebook includes two additional tabs:  
 

•  the Current Setup tab lets you "preview" current Gradebook settings;  
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•  the Preferences tab allows you to turn off automatic Gradebook points/calculations 
and weighting.  

Note 
Before you can set up your Gradebook, you'll need to determine your course content. 
Otherwise, no content items will appear in the Add New Items tab of your Gradebook 
setup. See the Help topic called Course Content for more information about adding 
course content.  

 
For information about grading students, see the Help topic “Assigning Grades.” 
 

Gradebook Preferences 
The Preferences section of your Gradebook lets you decide whether your Gradebook will display 
points and calculations to your students (86/100 or 86%, for example) or simply display letter 
grades (B+). If you choose to display points and calculations, you also have the option of 
"weighting" graded items relative to other graded items (i.e., making three Threaded Discussions 
worth 15% of the total course grade, or 5% each). Your Gradebook Preferences settings affect 
what information displays to both you and your students.  
 
If you enable points and calculations and assign a point value to each gradable item in your 
course, the Gradebook can calculate and display up-to-date letter and numeric grades for each 
student at the content item, unit, and course level. With this option enabled, students are given 
additional information in their Gradebook—information like "Current Course Points," "Current 
Course Average," and "Current Grade to Date," for example. Similarly, if you choose to apply 
weighting to your course assignments, the Gradebook can display each student's Course 
Weighted Average" to date.  
 
The Gradebook will calculate points (but not weights) by default. You can turn automatic point 
calculations off from the Preferences tab under Gradebook Setup. Remember that in doing so, 
however, students will not have access to some Gradebook features (like Current Grade to Date, 
for example). Likewise, you can turn on the weighting feature from the Preferences tab.  
 
Once you enter point or weight values into the Gradebook, these values are preserved should 
you turn points/weights off and then back on.  
 

Note In order to assign points (and weights) to gradable items, the Show Points and 
Calculations option must be enabled.  

 
 

Gradebook Setup 
When you click the Setup Gradebook button, you will see your current Gradebook 
configuration by default. All the content items you've added to your Gradebook appear on the 
left side of the list. If you've identified a content item to be "gradable" in a particular unit or week, 
the points possible for that item appear in the appropriate week. Similarly, if you've chosen to 
apply "weighting" to content items (i.e., to grade assignments as a percentage of the whole 
course grade), the weight percentage for each item displays above the point total. A summary of 
any course points and/or weighted percentages appears at the top of your current setup.  
 

Note 
If you are setting up your Gradebook for the first time, your Gradebook will be empty. 
(However, exams and items associated with a Dropbox are automatically added to your 
Gradebook.) Click the Add New Items tab or button to add items to your Gradebook.  
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You can click the Current Setup tab anytime as you set up your Gradebook to "preview" what 
your Gradebook will actually look like and display. 
Gradebook Keys  
There are several symbols in your Gradebook that may be unfamiliar to you. For example:  
 

•  A horizontal line (--) in your Current Gradebook Setup means that you marked the item 
as "gradable" in that unit but you have not yet assigned points to the item (only with 
points turned on)  
 
•  A horizontal line next to the "%" sign means you identified the item as "weighted" but 
that you have not yet assigned the weighted percentage (only if weighting is turned on). 
To assign points or weights, click the Assign Points/Weights tab under Setup 
Gradebook.  
 
•  Grades in brackets [ ] identify items that have been graded but have not yet been 
shared with the student  
 
•  The Gradebook also identifies items with a Dropbox associated with them, extra credit 
items, or items that have been excluded from the course grade.  
 

You can view the Gradebook Setup Key or the Gradebook Key any time from the bottom of the 
Current Setup or View Gradebook screens within the Gradebook should you need help 
interpreting these symbols.  
 

Adding Items to the Gradebook 
Adding items to the Gradebook is the first step in your Gradebook setup process. From the Add 
New Items tab under Setup Gradebook, you'll decide which course items and course tools you 
want to appear in your Gradebook. For example, this is where you'll determine that the "Course 
Outline" content item does NOT need to appear in the Gradebook, but that "Threaded 
Discussions" should.  
 
When you click the Add New Items tab, you'll see a list of every content item or course tool that 
is currently in your course.  
 

Note 
If you haven't added any content items to your course yet, only the default Course Tools 
(like Document Sharing and Webliography, for example), will appear on the Add New 
Items page.  

 
To add an item to your Gradebook: 

Step 1: Check the box next to each item you want to appear in your 
Gradebook. When you "check" an item, it means that the item will 
be visible to you (and to your students) when you view the 
Gradebook.  

Note 

Exams and content items that have a Dropbox associated with them 
are "checked" on this page by default, since it is assumed that they 
will be graded items. You can, however, "uncheck" either item. All 
other items will default to "unchecked" or "not showing" in the 
Gradebook.  

 

Step 2: Make sure you click Save Changes.  
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To add a custom item to your Gradebook: 

Step 1: Enter a name for the custom item in the Add Custom Item field at 
the bottom of the page. 

Step 2: Click Add. The new item appears in the list of content items.  

Step 3: Check the box next to the custom item name to add the custom 
item to your Gradebook. 

Step 4: Make sure you click Save Changes. 

Selecting Gradable Items 
Selecting which items in your course will be gradable is the second step in the setup Gradebook 
process. From this tab, you'll decide which instances of an item will actually be assigned grades. 
For example, perhaps you added Threaded Discussions to your Gradebook from the Add New 
Items tab and your course contains Threads in Units 1, 3, and 5. From the Select Gradable 
Items tab, you'll determine which Threads will "count" in students' grades—that is, which threads 
will be evaluated and graded. Perhaps the Threaded Discussion in Unit 1 is a "practice" and 
therefore ungraded, but the Threads in Units 3 and 5 will receive grades.  
 

Note 

You can also "exclude" a course item from the final course grade. This option allows you to 
display the item in the Gradebook and assign a point value to it, but not include the point 
value in the final course calculations. this is useful if you wanted to "grade" or provide 
feedback on a "practice" assignment (like the Thread in Unit 1 in the example above) but 
not include the practice score in the student's final grade calculations. See the Help topic 
“Exclude from Grade” for more information. 

 
To make an item gradable: 

Step 1: Make sure you're in the Select Gradable Items tab within Setup 
Gradebook.  

Step 2: Check the individual content items or course tools that you want to 
be able to assign grades to. Note that content items and course 
tools are listed on the left side of your screen; the Units in your 
course appear across the top. Example: If you want to use the 
Threaded Discussion in Unit 1 as a "practice" but then assign a 
grade to the Threaded Discussion in Unit 3, check the Threaded 
Discussion box under Unit 3 and leave the box in Unit 1 unchecked. 

Note 
If you don't see a checkbox for a particular content item in any given 
unit it means that you didn't add that item to that unit when you set 
up your course. Course tools are available in every unit. 

 

Step 3: Make sure you click Save Changes.  

 
Only items you identify as gradable will appear in your students' Gradebook.  
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Assigning Points/Weights 
Assigning point values (and, if you choose, weighted values) to course content is the third step in 
your Gradebook setup process. Once you've decided which items to display in the Gradebook 
and in which Units each item will be "gradable," you can assign point values or "possible points" 
to each item. From the Assign Points/Weights screen you can also:  
 

•  assign weighted values to content  
•  create extra credit items  
•  create "practice" assignments by excluding an item from the course grade  

 
Weighting assignments relative to other course content, creating extra credit items, and excluding 
assignments from course calculations are all optional features. However, you MUST assign 
point values to your Gradebook items if you want the Gradebook to calculate up-to-date 
grades for your students. If you determine the points possible for each gradable item, the 
Gradebook can use this value and the students' actual achieved points to calculate grades for 
each student at the content item level, the unit level, and the overall course level. If you do NOT 
assign points possible to a gradable item, nothing will display in the points possible field when 
you and your students view the Gradebook.  
 

Note 
You must have Use Points and Calculations turned on in the Preferences tab to be able 
to assign points possible, assign weighted percentages, and/or create extra credit/exclude 
from course grade items.  

 
To assign points to your Gradebook items: 

Step 1: Click the Assign Points/Weights tab in Setup Gradebook.  

Step 2: In the screen that appears, scroll down to enter the points possible 
for each content item you've marked as gradable. You'll only be 
able to enter points for those items you've identified as gradable. 
Unit numbers appear across the top of the screen—if you have 
more than one instance of a content item in a single unit, you'll see 
multiple fields in which you can enter possible points. The 
Gradebook will total and calculate student percentages based on 
the Total Points assigned to each gradable content item.

Note 

If you've created an exam in your course, the exam will already have 
a total point value assigned to it (since you assigned points to the 
exam questions when you created the exam). To see the "actual" 
points you assigned to an exam when you created the exam, click 
the Insert Points link for that particular exam. You can change or 
"override" the points possible for the exam by entering a new point 
value in the text box. This is one way you can "curve" an exam.  

 

Step 3: Make sure you click Save Changes.  

The optional Weighting feature allows you to easily "weight" or grade course items relative to 
other course content. For example, you have an exam worth 50 points, but you want it to count 
for 25% of a student's grade, instead of adjusting all your course points to "hit" this percentage, 
you can weight the exam in the Gradebook at 25%. Weighting allows you to easily "count" some 
course content items more than others without having to rely on point totals.  
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To apply weighted values to your Gradebook items: 

Step 1: Click the Assign Points/Weights tab in Setup Gradebook. 

Step 2: In the screen that appears, scroll down to enter a weighted percentage for each 
content item you've marked as gradable. For example, to make an assignment 
worth half of a student's grade, enter "50" in the " % " field for that assignment. 
Note that you'll need to enter possible points for the assignment, too, so the 
Gradebook will know how the student did on the assignment before applying 
his/her weighted percentage.

Note 

The Distribute Weight % feature allows you to spread a single 
weighted percentage evenly across multiple content items. For 
example, if you want Threaded Discussions in your course to be 
worth a total of 20% of the final course grade and you create three 
Threads, the Distribute Weight % feature will assign a weighted 
percentage of 6.66%, 6.66%, and 6.68% to each Thread, 
respectively. You don't have to do the math! Simply click Distribute 
Weight % to access this feature. Remember that you cannot 
distribute a weighted percentage to any content items that have 
been excluded from the course grade.  

 

Step 3: Once you've assigned a weight to all gradable items, click Save Changes. 
Although it's not required, for grading consistency, the sum of your weighted 
percentages should equal 100%. 

Note 
If you have the Weighting feature turned on but do not assign a weight 
percentage to a gradable item, that item will not count towards the final 
course grade (essentially, the item carries a weight of 0%).  

 

For information about creating extra credit items or to exclude an item from the final course 
grade, see the respective sections of this document.  
 

Extra Credit 
When you make a content item extra credit, the point value achieved by the student for that item 
is included in Gradebook calculations (i.e., is added to the student's achieved points). The point 
value possible for the content item is not included in Gradebook calculations (i.e., is NOT added 
to the total points possible for the course).  
 
To make an item extra credit: 

Step 1: Click the Gradebook tab, then click Setup Gradebook.  

Step 2: Click Assign Points/Weights. 

Step 3: Click the Extra Credit button. 

In the window that appears, check any content items you wish to make "extra credit." Any extra 
credit items will display with a green check mark icon throughout your Gradebook.  
 

Note You must have Points/Calculations turned on to see this feature. 
 
Make sure you save your selections.  
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Exclude from Grade 
If you want to provide graded feedback on an assignment but not include the grade in the final 
course grade, you can exclude the item from the course grade. This feature is excellent for 
"practice" assignments which you want to "grade" but not "count."  
 
To exclude an item from the course grade: 

Step 1: Click the Gradebook tab, then click Setup Gradebook.  

Step 2: Click Assign Points/Weights. 

Step 3: Click the Exclude from Course Grade button. 

In the window that appears, check any items whose point values you DO NOT want to include in 
the final course grade. Any "excluded" items will display with a red "exclude" icon throughout your 
Gradebook. 

  
Note You must have Points/Calculations turned on to see this feature. 

 

Assigning Grades 
As the instructor, you are responsible for entering students' actual grades (and any comments 
you may have) into the Gradebook. The Gradebook can then calculate and display up-to-date 
letter and numeric grades for each student (if you choose), which you can then export to a regular 
spreadsheet application.  
 

Note Before you can use your Gradebook you need to set up or "configure" it. Refer to the 
Gradebook Setup help topic for information about setting up your Gradebook.  

 
Within the Gradebook, there are many different ways you can view and assign grades to 
individual students. For example, you can select a specific unit or section of your course and view 
all your students' grades for that unit. You can open a single content item (like a Threaded 
Discussion) and assign each student a grade for that item. You can open the Gradebook record 
for an individual student and see all the grades for that student only. Honing in even further, you 
can view or grade one student's work for a single content item, and you can view the Gradebook 
from the student view. At the broadest level, you can view and edit a detailed "Show All" 
Gradebook matrix that displays all grades for all content items and all students. 
 
For more information about the different ways you can view and use the Gradebook, refer to the 
following sections of this document. Most instructors find the Quick Grade View most helpful, 
however. Also, it may be helpful to review the help topics for creating Extra Credit items and 
Excluding items from the Course Grade.  
 

Note You can sort any Gradebook view by student first name or student last name. 
 
In addition to assigning grades to students' work, you can also use the Gradebook to reset an 
exam for a student (allowing the student to essentially "re-take" the exam completely) and to 
grant a student additional time to take an exam (see the Help topic Quick Grade View for more 
information about resetting and granting additional exam time through the Gradebook).  
 
Note: You will not see any student names in your Gradebook until the students have been 
enrolled in your course. 
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Instructor View 
When you click the Gradebook tab, the Gradebook defaults to the Grades to Date view, showing 
each students' name along with their current grade. Depending on your Gradebook Preferences, 
the Grades-To-Date may include 1) a letter grade only (points and calculations off); 2) current 
course points and current course average (points and calculations on); or 3) course weighted 
average (points AND weighting on).  
 

Note 
By default, Gradebook Preferences and set to display points and automatic 
calculations. To show letter grades only, or to add weighted calculations to your 
Gradebook, go to Setup Gradebook and click Preferences.  

 
There are numerous ways you can view the Gradebook as an instructor. The following table 
explains some of the most useful Gradebook applications:  
 
TO DO THIS... ...click here or select this: 

To assign grades to all 
students for a single content 
item (like a Webliography 
assignment, for example)... 

...use the Select Gradebook View drop-down list to locate the 
content item you want to assign grades to. For example, if you 
created a Webliography assignment in Unit 4 of your course, 
select Unit 4 from the drop-down list and click Go. Since the 
Webliography is a course tool, locate the course tools section of 
the Gradebook in the screen that appears. Click Webliography at 
the top of the Gradebook. Enter a Numeric and/or Letter grade for 
each student, click to "share" the grade(s) with students, enter any 
comments, and click Save Changes. This is the Quick Grade 
View.  

To view the Gradebook by 
Unit or Week... 

...select Unit/Week XXX from the Select Gradebook View drop-
down list and click Go. You'll see your students listed down the left 
side of the Gradebook and all content items/course tools listed 
across the top. Click the content item name to open the Quick 
Grade view for that item.  

To see an individual 
student's grades for all 
content items... 

...click on the student's name. This option is available throughout 
the Gradebook. The units and content items in your course display 
on the left side of the Gradebook. The right side of the Gradebook 
includes three columns-- the first column displays the student's 
numeric and/or letter score for the item; the second column relates 
the item's score to the rest of the course grade (i.e., taking into 
consideration extra credit and excluded items and, if weighting is 
turned on, the weighted percentage of the item); the third column 
displays what is possible for the course (which is helpful because 
this column displays the points/percentage remaining for items 
that haven’t been completed yet. You can open a specific gradable 
z item for this student by clicking the student's score in the 
Gradebook (if the item has been graded) or by clicking the " * " if 
the item has not been graded. 

To edit, change, or add 
comments to a previously 
graded content item... 

...click on the student's name to display the Gradebook for that 
student. In the screen that displays, click the student's score. 
Make any changes to the grade or add comments as needed. 
Click Save & Close. You can also make global edits/changes to 
grades from the Quick Grade View. 
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To see a student's work 
while you're assigning a 
grade to the work... 

...click on the student's name to display all grades for that student 
(or simply locate the content item you want to grade using the 
Select Gradebook View drop-down list). Click the " * " next to the 
content item you want to grade. If this option is available, you'll see 
the student's work in the pop-up window. This option is only 
available for content items that contain student work, like Threads, 
Document Sharing, Journals, and Exams. 

To see a summary grade 
report of all content items, 
course tools, and custom 
course items for each 
student... 

...select Item Summary from the Select Gradebook View drop-
down list and click Go. For each student, you'll see a summary 
score for all content items, course tools, and custom course items. 
For example, if you had five Reading assignments in your course, 
each worth 20 points, the Item Summary would show each 
student's score out of 100 (five assignments X 20 points each) 
rather than showing five separate Readings scores. You'll also see 
each student's current course points and course average (or, with 
Weighting turned on, the Course Weighted Average). 

To see every grade for every 
content item for every 
student, including final 
grades... 

...select Show All from the Select Gradebook View drop-down 
list and click Go. This view shows you every grade first by week or 
unit, then by content item and course tool. Select this option if you 
want to export the Gradebook to a spreadsheet application. Avoid 
using this view for day-to-day grading, as it may take a few 
minutes to load. 

To see each student's final 
course grade (which may 
include a letter grade, course 
points and course average, 
or a weighted course 
average, depending on 
Gradebook Preferences... 

...select Grades to Date from the Select Gradebook View drop-
down list and click Go. You cannot edit the student's total 
achieved points in this screen, but you can edit the student's final 
letter grade and add comments. 

 
 

Student View 
Ever wonder how your students see the Gradebook? You can use the Student View option to 
view the Gradebook as your students see it. You can also use this view to grade one particular 
student. Students can view the Gradebook by Unit or by Item. As an instructor, you can also enter 
grades from the Student View.  
 
To view the Gradebook Student View: 

Step 1: Make sure you're on the View Gradebook screen within the Gradebook.  

Step 2: From any Gradebook view, click on an individual student's name. By 
default, you'll see the Gradebook: View by Unit as the student sees it.  
 
The units and content items in the course display on the left side of the 
Gradebook. The right side of the Gradebook includes three columns—the 
first column displays the student's numeric and/or letter score for the item; 
the second column relates the item's score to the rest of the course grade 
(i.e., taking into consideration extra credit and excluded items and, if 
weighting is turned on, the weighted percentage of the item); the third 
column displays what is possible for the course (which is helpful because 
this column displays the points/percentage remaining for items that the 



Copyright © 2008 eCollege 
Page 95 

student hasn’t completed yet.  

Note 

You can see the student view of the Gradebook by Item by clicking 
the View by: Item link in the top-right corner of the Gradebook. This 
viewing option is also available to the student and displays a 
summary score for all content items, course tools, and custom 
course items. For example, if there were five Reading assignments 
in the course, each worth 20 points, the Item Summary view would 
show the student's score out of 100 (five assignments x 20 points 
each) rather than showing five separate Readings scores (i.e., it 
displays a composite score for all Readings). You'll also see the 
student's current item points and course average (or, with Weighting 
turned on, the student's item points and the item's weighted 
percentage).  

 

Step 3: Open a specific gradable item for this student by clicking the student's 
score (if the item has already been graded) or by clicking the "*" if the item 
has not been graded. 

 

Quick Grade View 
The Quick Grade View is perhaps the most common and efficient way to assign grades in the 
Gradebook. This view lets you assign grades to all students for a single content item (like a 
Webliography entry, for example). You simply locate the content item (or course tool) in the 
Gradebook and then assign a grade for each student.  
 
To assign grades using the Quick Grade View: 

Step 1: Locate the content item (or course tool) in the Gradebook for which 
you want to assign grades. You can do this from just about any 
Gradebook view, although it may be easiest to locate the item in the 
Unit or Week View. 

Step 2: Click the content item or course tool name at the top of the 
Gradebook screen. For example, to grade a Webliography entry, 
click Webliography. The Quick Grade window opens, displaying 
each students' name down the left side of the window. 

Step 3: Enter a Numeric and/or Letter grade for each student. You can also 
enter a brief comment. Note: If you've accessed the Quick Grade 
view from the Item Summary, you will be able to enter a letter grade 
only from this view, as the student's numeric grade (or weighted 
average if Weighting is turned on) in this screen reflects a 
compilation of multiple content item scores. 

Note 
If you're "quick grading" an exam/quiz or an item that has a Dropbox 
associated with it, you will see some additional fields in the Quick 
Grade View. See the notes, below, for more information about these 
fields.  

 

Step 4: Click Save Changes. 
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Quick Grading Exams/Quizzes  
Occasionally, you may find that you need to either reset an exam for a student or grant a student 
additional time to take an exam. For example, if a student was in the process of taking an exam 
and his or her Internet connection was lost, the system would "think" that this student had already 
taken the exam and would, therefore, not let the student retake the exam. Depending on the 
individual situation, you can do one of two things. You can:  
 

•  Reset the exam. Resetting an exam clears ALL saved information from the individual 
exam database and allows the user to begin the exam again, as if he or she had never 
taken it.  
 
•  Grant additional time. This option simply allows the student to access the exam again 
for the amount of time you specify. Any information that was previously saved in the 
exam is still there. That is, the student starts the exam wherever he or she left off.  
 

Both of these options are available from the Quick Grade View for Exams.  
 
Quick Grading Dropbox Items  
The Quick Grade View for Dropbox items includes the Dropbox Status and a Return to Student 
option. The Dropbox Status field lets you know where the actual assignment is—whether it's in 
your Inbox or your Outbox. The Return to Student checkbox gives you the option of returning all 
assignments to all students at the same time, allowing you to grade ALL assignments before 
returning any of them. For more information about using the Dropbox, refer to the Help topic 
Using the Dropbox.  
 
 

Sharing Grades 
Most areas in the Gradebook include a Share Grade with Student option. This option is useful 
because it allows you to grade all your students' assignments and then return them all at once 
(rather than grading one assignment and returning it, grading another assignment and returning 
it, etc.). It also allows you to grade an assignment over a period of time and then return all 
assignments at once.  
 
The Share Grade with Student option is enabled by default, so if you don't want to share the 
grade immediately, you'll need to uncheck this option. Remember, too, that you can "share/hide" 
grades and assignments from the Dropbox as well.  
 

Note 

If you forget to "share" a grade, the student will not be able to see the grade in his/her 
Gradebook—even if you've graded the assignment. Similarly, if you set a Gradebook 
Review Date for an exam when you created the exam, students will not be able to view 
the exam grade in their Gradebook until the Review Date has passed. The Share Grade 
with Student and the Gradebook Review Date options are the two most common 
reasons that students cannot see grades in the Gradebook.  

 
If a grade appears within brackets [ ] in any Gradebook view, this indicates that the item has been 
graded but has not been shared with the student.  
 

Exam Statistics 
Your online course includes a powerful diagnostic tool called Exam Statistics. Accessed from 
the Exam Builder or from the Unit and Quick Grade views in the Gradebook, Exam Statistics 
provides both exam-level and question-level statistical analysis for the exam. You can download 
and save a copy of the statistics for archiving purposes (see below).  
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When you run Exam Statistics, you see exam-level analysis by default. Calculations at this level 
are useful because they let you see at a glance how the class as a whole performed on the exam 
and thus evaluate how challenging the exam was overall. When used over several courses, you 
may see trends in student performance which suggest refocusing your exam strategy. Exam-level 
calculations include:  
 

•  The number of respondents and number of questions on the exam  
•  High and low scores, as well as the range  
•  The mean, median, and mode  
•  The average difficulty of questions on the exam (Mean P-Value)  
•  Standard Deviation  
•  Frequency Distribution  
 

To drill down to question-level analysis, click the Question-Level Statistics tab. Calculations at 
this level are useful because they let you see how the class, as a whole, responded to each 
question in the exam. This level of analysis allows you to scrutinize the quality of each question, 
based on the accuracy of student responses. It also provides you with a way to identify questions 
that may not have been properly covered in the course presentation or that simply need to be 
rewritten or thrown out. Question-level analysis can help you identify areas where students may 
be weak and may suggest improving course materials in those areas. Question-level calculations 
include:  
 

•  The number of respondents and the frequency of each response  
•  The P-value (or difficulty level) of each question  
•  The Discrimination value for each question (the degree to which each question is 
separating the better students on the exam from the weaker students)  
 

Note 
Make sure you click the Definitions & Examples link on the Exam Statistics page for 
definitions, examples, and explanations of how each statistic was calculated. Also refer to 
the Notes section at the end of this topic for additional "tips." 

 
To view Exam Statistics: 
 

Step 1: Go to the Gradebook-->Unit view and click  ; or 

Step 2: Go to the Gradebook-->Quick Grade view and click  Exam 
Statistics; or  

Step 3: Go to the exam itself and click the Author tab. Click  Exam 
Statistics.  

 
You will need to download and save your exam statistics analysis report if you want to "archive" 
it. The report will not be stored in the system once the report screen has been closed. (You can 
always re-run the report, however.)  
 
To download an archive of the Exam Statistics: 
 

Step 1: Access the Exam Statistics from either the Exam Builder or from the 
Gradebook.  

Step 2: Click Download in the top-left corner. A new window appears.  



Copyright © 2008 eCollege 
Page 98 

Step 3: Click Save. You will be prompted to choose a location on your 
network or hardrive where the report will be saved as an .htm 
document.  

 
Exam Statistics Notes  
 
•  By default, analysis at the question-level displays in the order each question appears in the 
exam. However, you can sort exam questions by their "difficulty" level by clicking Sort By: 
Difficulty in the top-right corner of the report.  
 
•  You can run Exam Statistics before all exams have been submitted; however, only exams that 
have been submitted will be included in the analysis. "In Progress" exams will not be included in 
the results.  
 
•  Because of the nature of short answer and essay questions, no item analysis is available for 
these question types. However, you can click the View Student Responses link to view all 
student responses for the question. This allows you to read and evaluate each response against 
all other responses. You have the option of showing or hiding the student name associated with 
each response.  
 
•  Exams which allow multiple entry will use the data from the most current exam submission in 
the Exam Statistics report.  
 
•  If you edit an exam question after one or more students have responded to the question, all 
exam statistics will be lost for the edited or deleted questions. 
 

Exporting Grades 
You can export the current view of your Gradebook to a comma-separated value (.csv) file, which 
you can then open in any spreadsheet application. Doing so will allow you to take advantage of 
standard spreadsheet functions such as calculating mean, medium, average and other statistical 
calculations. Exporting the current view of the Gradebook also provides you with final grades in a 
format that you can turn in to your administration and keep as a backup for your records. 
 
To export the current view of your Gradebook: 

Step 1:  Click the Gradebook tab. 

Step 2:  Select the Gradebook View you'd like to export (i.e., Grades To Date, 
Unit 1, Item Summary, etc.) and click Go. 

Note
The Export View feature exports only the current displayed view of 
the Gradebook—that is, whatever is displaying on your screen. If 
you want to export your entire Gradebook (for archive purposes, for 
example), run the export from the Show All view. 

 

Step 3:  Click Export View in the top right corner of your screen. A new screen 
appears. 

Step 4:  Select the data format in which you'd like to export the current Gradebook 
view:  
 
Letter and Number Grades.  
Exports the current view with Letter grades and Number grades in 
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separate columns.  
 
Number Grades Only.  
Exports the current view with Number grades only.  
 
Letter Grades Only.  
Exports the current view with Letter grades only. 

Note 
If you choose to export letter and number grades or just letter grades, make 
sure you've actually assigned letter grades in your Gradebook. If you have 
not assigned letter grades, an empty column will display in your exported 
Gradebook file.  

 

Step 5:  Click Export. A File Download window appears. 

Step 6:  Select Save and click OK. A Save As window opens in which you can 
select a name and location for the exported Gradebook file. Click Save. 
The current view of the Gradebook file is saved with a .csv file extension 
in the location you specified. 

Note 
Unless you entered a name for the exported file in the Save window, the file 
is named using the date, followed by the view and data format. For 
example, a file exported on March 26th, 2006 would be named 
"032606ShowALL_Letterand#."  

 

Step 7:  Use any spreadsheet application to open the Gradebook file.  
 

Gradebook Tips and Tricks 
Following is a list of helpful "tips" and "reminders" that may help you use the Gradebook more 
efficiently. Note in particular the section dealing with Exams and the Gradebook—many 
preferences you set when creating an exam affect how the exam displays in the Gradebook.  
 

• The Quick Grade View is perhaps the most common and efficient way to assign grades 
in the Gradebook. This view lets you assign grades to all students for a single content 
item (like a Webliography entry, for example). You simply locate the content item (or 
course tool) in the Gradebook and then assign a grade for each student.  
 

• The Export Current View feature located on each Gradebook screen exports only the 
current displayed view of the Gradebook. If you want to export your entire Gradebook, go 
to the Show All view and then click Export Current View.  
 

• Remember that students cannot see a grade you've assigned them unless you mark the 
item to be "shared with student." The Share grade with student option appears in all 
Gradebook Details windows and within the Dropbox.  
 

• If you want to provide graded feedback on an assignment but not include the grade in the 
final course grade, you can exclude the item from the course grade. This feature is 
excellent for "practice" assignments which you want to "grade" but not "count." To 
exclude items from the course grade, click the Gradebook tab, click Setup Gradebook, 
click Assign Points/Weights, then click Exclude from Course Grade. In the window 
that appears, check any items whose point values you DO NOT want to include in the 
final course grade. Any "excluded" items will display with a red "exclude" icon throughout 
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your Gradebook.  
 

• The Weighting feature in the Gradebook (located under Setup Gradebook--> 
Preferences) allows you to easily "weight" or grade course items relative to other course 
content. For example, you have an exam worth 50 points, but you want it to count for 
25% of a student's grade, instead of adjusting all your course points to "hit" this 
percentage, you can weight the Gradebook. The Weighting feature is optional.  
 

• The Distribute Weight % feature allows you to spread a single weighted percentage 
evenly across multiple content items. For example, if you want Threaded Discussions in 
your course to be worth a total of 20% of the final course grade and you create three 
Threads, the Distribute Weight % feature will assign a weighted percentage of 6.66%, 
6.66%, and 6.68% to each Thread, respectively. You don't have to do the math! This 
feature is located under Setup Gradebook-->Assign Pts/Weights.  
 

• If you have the Weighting feature turned on but do not assign a weight percentage to a 
gradable item, that item will not count towards the final course grade (essentially, the item 
carries a weight of 0%).  
 

• If you're using Weighting in your Gradebook, your students will see a "Course Weighted 
Average" rather than a "Grade To Date." The Course Weighted Average reflects the fact 
that course content items have different "weights" assigned to them and, as a result, a 
strict "points achieved divided by points possible" calculation would not be accurate. 
Make sure you read the Learn More link in your Gradebook next to any Course 
Weighted Average for information on how the average is calculated and what it means.  
 

• The Extra Credit and Exclude from Course Grade features can be used with or without 
Weighting turned on; however, you must have Points/Calculations turned on.  
 

• The Dropbox and the Gradebook are tied together—if you enter a grade through the 
Dropbox interface, the grade will also appear in the Gradebook and vice versa. 
Remember that you must return the assignment to the student before the student can 
see the assignment in his/her Inbox.  
 

• The Gradebook will calculate and display up-to-date points and calculations by default. 
With this option enabled, students have access to calculations like Grade to Date, 
Current Course Average, and Points Possible. However, you can turn this feature off 
from the Preferences tab under Setup Gradebook. Remember that in doing so, 
however, students will not have access to calculated figures (like Current Grade to Date, 
for example). Remember, also, that you must have assigned points to gradable items in 
order to display Gradebook calculations.  
 

• You can assign a Final Letter Grade from any view in the Gradebook in which you see 
the Current Course Points column. Simply click the student's current course points. 
Click Save & Next to go to the next student.  
 

• To accurately show students their "Current Grade to Date", enter zeros (0's) in any 
incomplete items to that point in the course. The Gradebook only calculates items that 
have been graded, so if a student did not turn in an assignment, the total possible points 
for that assignment would not "figure" into the total points possible for the course, 
skewing the student's grade to date.  
 

• If you've used Weighted percentages in your Gradebook, the Student View of the 
Gradebook is an excellent way for students to see their current "weighted" grade as well 
as remaining course work and its relative weight. For example, a student who did poorly 
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on one assignment can see the "big picture"--perhaps that assignment was only worth 
10% of the final course grade.  

 
 
EXAM/GRADEBOOK TIPS  
 

• Many of the options you select when setting up an exam affect the Gradebook display for 
both you and your students. For example, if you want students to be able to view their 
exam/quiz scores in their Gradebooks without you having to manually enter their points 
or scores, be sure to check the Automatically display objective score of a finished 
exam to students in the Gradebook when setting up the exam. This option isn't 
enabled by default.  
 

• If you want students to automatically be able to see their scores/grades for an exam, 
remember to set a Gradebook Review Date when you create the exam. If you don't set 
a review date, students will be unable to view your comments and/or scores in their 
Gradebooks.  
 

• You can Reset a student's exam through the Gradebook Details window. Resetting an 
exam clears ALL saved information from the individual exam database and allows the 
user to begin the exam again, as if he or she had never taken it.  
 

• You can Grant a student additional time on an exam through the Gradebook Details 
window. For example, if a student was in the process of taking an exam and his or her 
Internet connection was lost, the system would "think" that this student had already taken 
the exam and would, therefore, not let the student retake the exam. This option simply 
allows the student to access the exam again for the amount of time you specify. Any 
information that was previously saved in the exam is still there. That is, the student starts 
the exam wherever he or she left off.  
 

• You can essentially "curve" an exam by modifying the points possible for the exam in the 
Gradebook. See the Help topic Assigning Points/Weights to Gradebook items for more 
information. 
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Course Tools 
 
The course tools help you communicate and interact with your students. Most of the course tools 
are located on tabs across the top of your course, and include things like email, announcements,  
Dropbox, and chat rooms. Your students can use these same tools to communicate with you and 
with other students.  
 

Posting Announcements 
You can post announcements for your course on your Course Home Page. Students will see any 
announcements or messages you post the next time they log in.  
 
Use announcements to welcome students to the course, give specific instructions about a course 
change, inform students about changes in office hours, or explain other urgent situations that 
might otherwise get lost in the email shuffle. You can also set Display Dates for your course 
announcements so that you determine exactly when to display and when to withdraw each 
announcement. As a result, you can create multiple announcements at one time and then control 
when each “appears” and “disappears” over the duration of the course. 
 
Posting announcements can reduce the time you spend responding to similar email messages 
from many students. 
 
 

 
 
Only instructors can post and delete announcements. Also, a permanent record of all course 
announcements is stored within the course.  
 

Adding Announcements  
As an instructor, you can post, edit, or delete course announcements on the Course Home Page. 
Your students can only view announcements.  
 
To add an announcement: 

Step 1: Click the Course Home button on the left side of your course.  
Step 2: Click the Author tab to switch to Author mode. 

Step 3: Make sure the Edit Course Home button in the top left corner is pressed. 

Step 4: Click Add new announcement. The Add/Edit announcement dialog 
appears.  
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Step 5: Enter a short subject for your announcement. This is the text students will 
see and click on to read the announcement. 

Step 6: If the announcement is text only, enter the text in the Announcement 
field. For information on formatting the announcement text with the Visual 
Editor, see the Help topic Formatting Content. If you'd like your 
announcement to link to a file, click the ‘link’ button and refer to the Help 
topic Adding links, images, and files. 

Tip: If you're creating a course that must meet Section 508 Accessibility 
Requirements, you'll need to switch to the HTML view in the Visual Editor 
and verify that your HTML code meets the requirements. To see specific 
508 requirements or for more information, see the Help topic under 
Course Creation called Accessibility Requirements or go to 
http://www.access-board.gov/sec508/guide/1194.22.htm 

Step 7: Select Display Dates for your announcement. You can enter a date 
directly into the text box (mm/dd/yyyy), or you can click the ‘calendar’ icon 
to select a date from the calendar. Display Dates default to the course 
start and end dates, so if you don’t enter Display Dates, your 
announcement will remain on the Course Home Page throughout the 
entire course unless you delete it or change its Display Date.  

Step 8: Click Post Announcement.

 
 
To edit or delete an announcement: 

Step 1: Click the Author tab from your Course Home Page. 

Step 2: Click the announcement you wish to edit. This "expands" the 
announcement so you can see the entire announcement.  

Step 3: Click the Edit button below the text of the announcement to edit the 
announcement. Make any changes to the announcement. When 
you're done editing, click Post Updated Announcement.  
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Step 4: Click the Delete button below the text of the announcement to 
delete the announcement. 

Note:  If you simply want to “hide” an announcement from students (i.e., 
not delete it entirely) you can modify the Display Date for that 
announcement.  

 
 

Viewing Announcements  
Announcements appear with the most recent announcement at the top of the announcement list. 
Remember, however, that if you set specific Display Dates for a particular announcement, that 
announcement will ONLY display during the dates that you specified. That is, if it’s before the 
Display Start Date or after the Display End Date, the announcement will not appear on the 
Course Home Page. (To display the announcement, you can always modify the Display Dates.)  
 
To view course announcements: 

Step 1: Click Course Home in the upper left corner. This will take you to 
the Course Home Page, where you'll see the announcements.  

Step 2: Click the announcement you want to view, or click the "plus" next to 
the announcement. This will open or "expand" the announcement. 
You can open or "expand" all course announcements by clicking 
Expand All in the upper right-hand corner of your screen.  
 
Click the subject of the announcement, or click the "minus" sign to 
the left of the announcement, to close or "compress" individual 
announcements.  

 

Viewing What’s New 
As an instructor, the What’s New feature on the Course Home Page lets you monitor student 
activity in your course. From What’s New, you can see when individual students contributed to a 
select area of the course. This is helpful to you as an instructor because you don't have to search 
through every unit or content item to see which students have contributed to various course 
areas.  
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For example, if you wanted to see if there were any new postings to the Unit 1 Threaded 
Discussion, you could sort your What’s New list by course item and see that the threaded 
discussion for Unit 1 had 5 new responses and 3 new postings. Similarly, if you wanted to see 
how student “Michelle Petersen” was participating in the course, you could sort by name and see 
that Michelle Petersen had posted 2 responses in the threaded discussion and had posted a site 
to the Webliography.  
 
You can limit the number of items you want to display in your What’s New list by setting date 
options, and you can change the What’s New view.  
 
To set date restrictions on your What’s New list: 

Step 1: Go to your Course Home page and locate the What’s New feature. 
(It should be right after your course Announcements.) 

Step 2: Select a number from the See What's New Since Last drop-down 
list. Your What’s New list will display all course activity that occurs 
within the time frame your specify. For example, if you select "3 
days" from the drop-down list, your What’s New feature will display 
a list of all course activity that's taken place in the last 3 days. 
Student activity that occurred 4 days ago will not be listed. You can 
change this number at any time. 

 
To change the What’s New view: 

Step 1: If there has been more than one instance of activity in your course, 
you can click Expand All to see a complete view of all course 
activity. Click Compress All to "close up" or compress your list.  

Step 2: If there has been more than one instance of activity in your course, 
you can click Course Item in the top-right corner of your What’s 
New list to sort your list by course item. Click Name in the top-right 
corner of your What’s New list to sort your list by student name. 
You can click a specific content item to go directly to that item 
within your course. 

 
For students, the What’s New list looks similar, although they do not have access to the "sort by 
name" option. Students see a list of content items and What’s New since their last login. For 
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example, when a student logs in, he/she will see a list of course content items such as 
Webliography, Document Sharing, and Threaded Discussion and beside each item a breakdown 
of new activity since their last login.  
 

Viewing the Course Checklist  
The Course Checklist feature on the Course Home Page is a great resource for students. From 
the student view, the Course Checklist displays a list of all course assignments and their 
associated due dates, as well as a checkbox for each item so that students can monitor their 
progress in regard to assigned coursework. Ideally, this course "task list" will help students be 
aware of assignment due dates and prompt them to complete assignments on time.  
 
Due Dates can be assigned to content items from the Course Scheduler or the Edit Schedule 
button.  If a due date is not assigned to a content item, the content item will still display for the 
student so that they may check it as completed; however, there will not be a due date listed next 
to that content item. 
 

 
 
Students can sort their Course Checklist by Unit or by Due Date. Remember, too, that (except 
for exams) students manually check off the items in their Course Checklist-- the checklist is not 
integrated with the actual content items. As a result, a student may check off an item that is not 
necessarily complete. Additionally, the Due date feature does not restrict student access to 
content items and is designed to be used only as a helpful display for students.  Restricting 
access to content items is controlled through the Restrict access before/after this date 
checkboxes in the Course Scheduler or Edit Schedule window for each content item. 
 

User Activity 
The User Activity feature tracks the amount of time (in minutes) that individual students spend in 
the course and where in the course they spend their time. With the User Activity feature, you can 
see how much time a student spent in an individual unit or content item, as well as the dates on 
which the student accessed the course. You can also export the data in the User Activity feature 
to a spreadsheet.  
 
There are three ways you can view User Activity: 
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• View by Unit or Course Tool. This option lets you look at a specific unit in your course 
(like a Readings unit, for example) or at a specific Course Tool (like Webliography or 
Chat, for example) and see how much time each individual student spent in that 
particular unit or tool.  
 

• View by Date. This option lets you specify a date range (perhaps the week before 
Thanksgiving, for example) and see how much time each individual student spent in the 
course during that time period.  
 

• View by Student. Although this option is not available from the main Select View drop-
down list, it is available from either the View by Unit view or the View by Date view. 
Viewing User Activity by Student shows you a bar chart graph of how much time one 
particular student spent in each unit and/or in a specific content item(s).  

 
Note: It is important to remember that the User Activity time may not necessarily reflect the time 
students were actually working in the course. User Activity times merely provide information 
regarding how long a student spent in each area of the course—a short user activity time may be 
due to a student quickly entering a course area, printing the material, and then working offline. 
Similarly, if a student does not log out of their course or logs out infrequently, the User Activity 
time displayed may be higher than the student's actual time spent in a particular area of the 
course.  
 
To view user activity by unit or Course Tool: 

Step 1: Click the Gradebook tab in your course. 

Step 2: Click User Activity. By default, the User Activity Summary displays 
user activity by unit. You'll see a matrix of student names (on the 
left) and course units/tools (across the top). The amount of time 
each student spent in each area displays (in minutes) in the matrix.  

Step 3: If you click on a unit number (at the top of the screen), you'll see all 
the content items in that unit, as well as the amount of time each 
student spent in each item. If you click on Course Tools, you'll see 
all the Course Tools in the course, along with the amount of time 
each student spent in each tool. 

Note Click on a specific student's name (on the left), to see the User 
Activity summary for that one user. 

 

Step 4: Click Export User Activity to export the current view to a comma-
separated value (.csv) file. If you select this option, you will save the 
file to your hard drive (or other location) as a .csv file, which you 
can then open using any spreadsheet application. 

To view user activity by date: 

Step 1: Click the Gradebook tab. 

Step 2: Click User Activity. 

Step 3: Select View by Date in the Select User Activity View drop-down 
list and then click Go. A matrix of student names (along the left) and 
the current week's dates (across the top) displays. Any user activity 
during the current week displays in the matrix (in minutes). 

Step 4: To view user activity during a specific period of time, use the drop-
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down boxes to select From and To dates and then click Go. Any 
user activity during the dates you selected displays in the matrix.  

Note Click on a specific student's name (on the left), to see the User 
Activity summary for that one user. 

 

Step 5: Click Export User Activity to export the current view to a comma-
separated value (.csv) file. If you select this option, you will save the 
file to your hard drive (or other location) as a .csv file, which you 
can then open using any spreadsheet application. 

To view user activity by student: 

Step 1: Click the Gradebook tab. 

Step 2: Click User Activity. 

Step 3: From the default view, simply click on a specific student's name (on 
the left). The User Activity summary for that one user displays.  

Step 4: Click the "expand" or "+" button to open each unit and view the 
student's individual user activity time for each content item within 
the course. Expand the Course Tools section at the bottom of the 
list to view time spent in Course Tools. 

Step 5: Click Export User Activity to export the current view to a comma-
separated value (.csv) file. If you select this option, you will save the 
file to your hard drive (or other location) as a .csv file, which you 
can then open using any spreadsheet application. 

Note 

You can also access the User Activity tool from an individual content item: 
  
(1) Select the content item in Author mode;  
(2) Click the Toolbox button for the content item;  
(3) Click View User Activity.  

 
 

Emailing Class Members  
The Email tool is a convenient and effective way for you and your students to communicate with 
each other. You can use the email tool to address student questions, concerns, and issues in a 
one-to-one private email, or you can send messages and files to a group of students. When a 
user is enrolled in an eCollege course, his/her email address is uploaded into that course.  
 
Students use the email tool in much the same way: they can send private messages to instructors 
regarding course or assignment questions or other personal concerns, or they can use email to 
communicate with other group members on collaborative projects.  
 
To send an email: 

Step 1: From any page in your course, click the Email course tool at the top 
of the screen.  

Step 2: Select who your email should go to in the Select Recipients box. 
You can send your email to All Class Members, groups of students 
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that you have set up within the course, a single class member, or 
multiple class members. To add a recipient, highlight the name and 
then click Add. 

Note:  If you add a Group name to the Recipients list, the individual group 
members' names will display in the list (rather than the name of the 
group). 

Step 3: The names you select appear in the Recipients box. You can 
remove a single recipient from this box by selecting the recipient's 
name and then clicking Remove. You can remove all recipients by 
clicking Remove All. 

Step 4: Enter a Subject for your message, and type your message in the 
space provided.  

Step 5: To attach a document to your email, use the Browse button to 
locate the file you want to attach. Select the file in the dialog that 
appears and click Open. The file path appears in the email 
Attachment field.  

 Tip: You can only add one attachment per email.   
 

Step 6: Check the Blind Copy These Recipients box if you want the email 
recipients on the list to be unable to see the other recipients of the 
email. For example, if you send an email to a group of students who 
did poorly on a quiz, you don't want these students to see the other 
students who also did poorly.  

Step 7: Click Send Message. A copy of any email you send will be sent to 
your personal email account as well.  

 

Using Chat Rooms  
Like a regular online chat room, the Chat tool lets you and the students in your course 
communicate with each other in real time. You can also use the chat tool to:  

• View chat logs, which are archived chats from the course  
• Create separate chat rooms for different purposes or groups  
• Send private messages to an individual participant  
• "Follow" one another to web sites related to the course discussion  

Participating in a Chat 
Chat rooms allow you and your students to communicate in real time. 
  
To participate in a chat room: 

Step 1: Click the Chat tool at the top of your screen. 

Step 2: Click the chat room you'd like to participate in. A confirmation window 
opens. 
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Step 3: 

Click  to open the chat room. 

Step 4: Type your message in the text box at the bottom of the chat room and 
press the Enter key.  

 
 
To send a private chat message: 

Step 1: From within the chat room, double-click the name of the person you 
want to send a private message to. A small window appears.  

Step 2: In the window, type the private message text. 

Step 3: Press the Enter key. Your message will be seen only by the 
recipient to whom you sent the message.

 
To add a link to a Web site in the chat room: 

Step 1: Before you begin, ensure that: 
• Web Touring under the Options menu in the chat room is 

On. Turning on Web Touring ensures that the Web page to 
the URL link you are sending opens for the recipient in a 
separate window.  

• Pop-up Blocker under the Tools menu in your Web browser 
is turned Off. Turning off Pop-up Blocker ensures that the 
Web page to a URL link you send or receive opens. 

Step 2: Type the full URL address in the field at the bottom of the chat room 
and press the Enter key. Your URL displays in the chat room. Note: 
The URL address must include http://www. for the recipient of the 
link to view the Web page.



Copyright © 2008 eCollege 
Page 111 

 
Creating a new chat room 
There is a main chat room for every course. As an instructor, you may want to create different 
chat rooms for different purposes or groups. You can also rename, edit, or delete an existing chat 
room.  
 
To create a chat room: 

Step 1: Click the Chat tool at the top of your screen. 

Step 2: Click Add New Room at the top of the page. 

Step 3: Type a name for the room and a short description of what kind of 
discussion should take place in that room. 

Step 4: Check the Create a private room box if you don't want a chat log 
created for the new chat room. By default, a chat log is created for 
every chat room. 

Step 5: Determine who can access the new chat room by selecting an 
option from the Assigned To drop-down list. You can make the 
chat room available to all class members or to specific groups 
you've defined within the course. 

Step 6: Click Create Room. 

 
To rename, edit, or delete a chat room: 

Step 1: Click the Chat tool at the top of your screen. 

Step 2: Locate the Edit button beneath the chat room you want to rename, 
edit, or delete.  

Step 3: Click Edit to rename the chat room or edit its description. Click 
Delete to delete the chat room. Note: You cannot delete the main 
chat room.  

Step 4: Click Save Changes. 

 

Using Chat Logs  
Chat sessions are automatically saved in chat logs, which you and your students can view, save, 
and print. Remember, however, that as an instructor, if you delete a chat room, the logs for that 
room are no longer available.  
 
You may choose to share interesting chat logs with students by copying the logs into a MS Word 
document and attaching that document to an email message, or by posting it in the course. 
 
To view a chat log: 

Step 1: Click the Chat course tool. 

Step 2: Locate the specific chat room for which you'd like to view the log 
and click View Chat Logs to the right of the chat room name. A 
Chat Log Archive displays.  
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Step 3: Click a specific archive date to open the archive and see the chat 

log for that date.  
 
To print a chat log: 

Step 1: Make sure the text information you want to print is visible on your 
screen.  

Step 2: Use the Print function on your browser to print the screen. 

 
To save a chat log: 

Step 1: Highlight the text you wish to save. 

Step 2: Click CTRL + C to copy the text to the clipboard. 

Step 3: Open a new document (a MS Word document, for example) and 
click CTRL + V to paste the contents of the clipboard into your new 
document.  

 
Using ClassLive 
The ClassLive tool is an interactive graphical chat tool that allows you to communicate with your 
students in real time. For example, you can place or draw objects on the whiteboard, you can 
share a software application from your computer, you can send and receive graphed or plotted 
equations, you can participate in synchronous chat sessions with your students, you can 
broadcast live audio, and you can work through complex mathematical, accounting, and 
chemistry problems one step at a time. You can use ClassLive with a group of students, or you 
can use the tool for one-on-one help. 
 
Note: The ClassLive feature can be enabled or disabled at an institution level. If you don't see the 
ClassLive tool on your Chat tab, your institution has chosen to disable the feature. 
 
Before you begin: 

• The ClassLive tool requires you and your students to meet specific technical 
requirements. To view these requirements, click the Technical Requirements link on the 
main ClassLive page of your course.  

• View the ClassLive Tutorial to orient yourself to the ClassLive environment. To view the 
tutorial, click the ClassLive Tutorial link on the main ClassLive page of your course. You 
should also see the training page for additional information about how to use the 
available tools to maximize your ClassLive experience.  
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• The ClassLive tool is enabled by default. However, if you don't see a link to ClassLive on 
the Chat tab of your course, the feature can be turned off or disabled. Instructors can turn 
on ClassLive from the Course Preferences page. Remember, you can always use the 
regular Chat feature of your course to conduct simple synchronous discussions.  
 

• Be sure to join ClassLive 5 – 10 minutes prior to the start of your session and set your 
Connection Speed to the Internet.  
 

• Close all applications running on your computer that you don't intend to use with your 
ClassLive session. Running other applications on your computer (such as an Internet 
browser) can slow down your connection to ClassLive.  

How can I use the ClassLive tool? 
The ClassLive tool is much more than an interactive whiteboard. Following are some ideas to get 
you thinking about how you can use this versatile tool in your course:  
 
Note: The following list includes some feature uses that are only available to ClassLive Pro users. 
Check with your administrator about which ClassLive version you are running. 

• Use ClassLive to meet with students one-on-one to help them individually with course 
work. ClassLive is especially useful for helping students with mathematics, accounting, 
and chemistry equations.  
 

• Use ClassLive to present a PowerPoint slideshow or display other uploaded images. Use 
the toolbar to add notes to slides and to point out important sections of the slide or image.  
 

• Use the Application Sharing feature to teach students how to use applications like Excel, 
PowerPoint, or any other application on your computer. Students can watch as you walk 
them through menu options, toolbars, and other features of the application.  
 

• Use the ClassLive Whiteboard to have students complete work in a synchronous setting, 
as if they were "coming to the chalk board."  
 

• Share a Web site with your students with the WebTour feature and have your students 
follow you through the site.  
 

• Incorporate the broadcast audio feature into your session to walk students through a 
presentation, emphasize specific sections of the whiteboard, notify students that you're 
switching boards, or to simply add a "personal" touch to your online course.  
 

• Upload course notes and highlight areas of importance.  
 

• Use the Graphing Calculator to create visual representations of equations. Have students 
make modifications to the equation, re-create the graph, and send the new graph back to 
you.  
 

• Use the Polling feature to ask your students if they're ready to move to the next slide. 
You'll know almost immediately whether they're ready to go on.  
 

• Capture a screen shot from another application on your computer, display the screen 
shot on the board, and discuss it with the students.  
 

• Turn the ClassLive session into a "live" forum in which groups can present their projects 
to the rest of the class.  
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• Use taped or recorded course sessions for students to use as a review or to catch up 
from a missed class.  
 

• Use Quiz Manager to conduct live quizzes and review the results with students as a class 
or privately.  
 

• Personally help students who might be falling behind the rest of the class by opening a 
Breakout Room and tutoring them individually or in small groups.  
 

• Share a Web site with your students with the WebTour feature and have your students 
follow you through the site.  

Participating in ClassLive 
Participating in ClassLive is easy! Use the Participants window to view the current students in 
your session and control their privileges to speak, send messages, use the whiteboard, use the 
graphing calculator, host application sharing, respond to poll questions, and more. Upon entering 
a session, your name displays in blue text in the Participants window. During a session, the 
Participants window uses "activity lights" to indicate to you when a student experiences delays in 
receiving content or steps away from a session. 
 
Note: As a stand-alone tool, ClassLive includes a training page with video tutorials and additional 
documentation provided by Elluminate, Inc. 
 
To raise your hand: 

• In the Participants window, click on the Raise hand button. You know when a student is 
raising their hand when the bottom part of the Participants window flashes and you hear 
an audible beep. The Participants window shows the total number of hands raised. A 
number in the column next to each student’s name indicates the order in which the 
student's hand was raised. 

 
To lower your hand: 

• In the Participants window, click the Lower hand button. To lower a student’s hand, 
click the number in the column next to that student’s name. To lower all hands, click the 
column header. When a hand is lowered, the number is removed from the hand column 
and the queue is reordered. 
  

To grant privileges: 
• Depending on how your ClassLive session is configured, students can only communicate 

to you by raising their hand and sending text messages. As the instructor, you can grant 
students privileges to speak using audio and send text messages to other students within 
a ClassLive session. 
 

To use emoticons: 
• Express yourself! Instructors and students can use the emoticons to communicate 

laughter, applause, confusion, or disapproval. When you select an emoticon, everyone in 
the room sees the icon flash next your name. 
 

To leave/rejoin a session: 

Step 1: From the Session menu, select Away. Your name grays out in the 
Participants window to indicate to everyone that you are away from 
your computer. 

Step 2: From the Session menu, de-select Away to rejoin your session. 



Copyright © 2008 eCollege 
Page 115 

 
To take a poll: 

Step 1: From the Tools menu, select Polling, and then select a type of poll 
to use. By default, the Yes/No poll is selected. 

Step 2: Determine if you want to show or hide the polling responses from 
your students. On the toolbar, the state of the polling column is 
readily visible: 

• hides the responses from the students.  

• shows the responses to the students. 

Hiding responses is useful when you don’t want students to be 
influenced by each others answers.

Step 3: In the Chat window, type your question. (Optionally, if you hid the 
responses from the students, you might choose to show the 
responses.) 

Step 4: When you are done with the question, click the column header to 
clear all the answers. At any time, you can ask the students another 
question using the same poll or a different type of poll. 

 
 
To turn off polling: 

• From the Tools menu, select Polling, and then select None. The polling column and 
response buttons clear.  

Audio & Messaging 
You can use any of ClassLive's audio and messaging tools to speak to all students or individually 
in a private session on the side. The messaging area is where you can send text messages to 
everyone, selected students or to one student in the session. Students can always send a text 
message to you, even when they do not have messaging privileges. Students' messages will 
display as a private message to you and other instructors in the session. Depending on your 
session configuration, you can monitor all messages that are sent, including private messages. 
Messages are color-coded for your benefit: Black text means the message was sent to everyone 
in the session, Blue text means that you sent or received a message, and Red text means that a 
student has sent a private message to another class member.  
 
Note: As a stand-alone tool, ClassLive includes a training page with video tutorials and additional 
documentation provided by Elluminate, Inc. 
 
To talk using audio: 
(The ClassLive Audio feature is only available to ClassLive Pro users. Check with your 
administrator about which ClassLive version you are running. You can learn more about using 
ClassLive Audio on the training page provided by Elluminate, Inc.) 

Step 1: In the Audio window, click Talk when you want to speak. The Talk 
button changes to ON THE AIR.

Step 2: Click ON THE AIR when you are done talking to release your 
microphone. Only one person can speak at a time because the Talk 
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button cannot be selected when someone is speaking. Remember 
to always release your microphone after talking so others can reply. 

 
To send a text message: 

Step 1: Type your message in the text field below the discussion area in the 
Chat window. 

Step 2: Click the To: drop-down menu and from the options listed, select a 
recipient of your message.

Step 3: Click Send. Your message displays in the discussion area. 

 
To send a text message to specific students: 

Step 1: On your keyboard hold down the Shift or Ctrl (Command) key and 
click on the names of the students you want to select. The students' 
names are highlighted when selected.

Step 2: Type your message into the text field below the discussion area. 

Step 3: Click the To: drop-down menu, and select Selected. 

Step 4: Click Send. Your message displays for the selected students. 
Remember, private messages display as blue text in the discussion 
region. 

Note: Click  to track when all messages are sent and to see 
a date and time stamp next to each text message. Click  
again to hide the date and time stamps.  

 
To filter a text message: 

Step 1: From the Chat window, click the Show drop-down menu. 
Step 2: Select the names of the students whose messages you want 

displayed. When you make your selection, only the relevant 
messages display in the discussion region. You can change your 
selection at any time.

 
To save a text message: 

Step 1: From the File menu, select Save, and then select Chat 
Conversation. 

Step 2: In the Save Chat Conversation window, select the file name and 
location of where you want to save the file.

Step 3: Click Save. The suffix .txt is added to the filename. You can use 
Notepad, WordPad or any word processing application to read the 
text file. Remember, you can only open saved message files 
outside of ClassLive. 
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To open a breakout room: 
(The ClassLive Breakout Room feature is only available to ClassLive Pro users. Check with your 
administrator about which ClassLive version you are running.) 

Step 1: In the Participants window, click on the names of the students you 
want to move to a breakout room. Hold down your Shift key to 
select multiple students.

Step 2: Right-click (Mac users hold down your Ctrl key and Right-click 
again) and select Send to Breakout Room, and then select from 
the list of available rooms.

To move between breakout rooms: 
(The ClassLive Breakout Room feature is only available to ClassLive Pro users. Check with your 
administrator about which ClassLive version you are running.) 

Step 1: In the Participants window, select your name and Right-click (Mac 
users hold down your Ctrl key and Right-click again).

Step 2: From the context menu, select Send to Breakout Room, and then 
select the room you want to join.

 
To monitor breakout rooms: 
(The ClassLive Breakout Room feature is only available to ClassLive Pro users. Check with your 
administrator about which ClassLive version you are running.) 

Step 1: From the Whiteboard Screen menu, select the name of the 
breakout room or screen you want to view.

Step 2: Once in the breakout room screen group, use the navigation arrows 
to view all the screens. (This will not affect any of the students.) 

Step 3: To move back to the main room, select the main room or the screen 
from the Whiteboard Screen menu.  
Note: When students raise their hands or send you a private text 
message while in a breakout room, ClassLive notifies you even if 
you are not in the same breakout room or if you are in the main 
room. 

 

Whiteboard 
The whiteboard is the main presentation window. Use the whiteboard to present slides or as a 
work area where you and your students can write, draw, or type. As the instructor, you must 
manage all the screens in the whiteboard, the screen content, and the student privileges to view 
and work on the whiteboard screens.  
 
Note: As a stand-alone tool, ClassLive includes a training page with video tutorials and additional 
documentation provided by Elluminate, Inc. 
 
To use whiteboard tools:  

Step 1: Click on any one of the tools, located on the left side of the 
whiteboard, to select it. Editing attributes for the selected tool 
display at the bottom of the whiteboard in the "Quick Editor."  
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Step 2: Position your cursor on the whiteboard, and then click and drag the 
mouse to begin drawing.

Step 3: Release the mouse button to complete the action. 

 
To load a presentation:  

Step 1: In the whiteboard area, click on the Load Presentation button. The 
Select Screens window opens.

Step 2: Select one of the following screen insertion locations:  

• After selected, inserts the file after the current screen  
• Before selected, inserts the file before the current screen  
• Replace screen, replaces the current screen  
• As sub-topic, inserts the screen as a sub-topic of the 

current screen  

Step 3: Determine whether you want to insert the file from the Current 
Screen or the Selected Screens. Select either:  

• Current Screen, to insert the file into the current screen  
• Selected Screens, to view all of the available screens and 

select multiple screens 

Step 4: Click OK. The Load File window opens. 

Step 5: Browse to the directory of the file to which you want to upload and 
click Open. The presentation opens. 

 
To share an application: 
(The ClassLive Application Sharing feature is only available to ClassLive Pro users. Check with 
your administrator about which version of ClassLive you are running.) 

Step 1: From the Tools menu, select Application Sharing, and then select 
Host Applications. The Select window opens.

Step 2: On the Applications tab, do one of the following to share an 
application or a region of your desktop.  

• To share an Application, highlight the appropriate 
application(s).  

• To share a region, click on the Region tab and define the 
region you are sharing.  

• To share your entire desktop, on the Region tab select the 
option, Share entire desktop. 

Step 3: Click OK. The Hosting Notification window opens with a 
confirmation message. 

Step 4: Click OK. Your window layout will be with the ClassLive main 
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window in the docked left position on your monitor and what you 
are sharing will be to the left of the main window. The Application 
Sharing window opens on the student's monitor. 

 
To link to Web sites during a session: 
(The ClassLive WebTour  feature is only available to ClassLive Pro users. Check with your 
administrator about which version of ClassLive you are running.) 
 

Step 1: From the Tools menu, select WebTour, and then select Start a 
WebTour. 

Step 2: In the Enter URL window, type the URL to the Web site you want 
your students to view and click OK. 
 
Note: Only one instructor at a time can control the WebTour 
window (be the ‘Tour guide’). To become the Tour guide, select the 
Tour guide check box in the WebTour window. If you do not have 
the Tour guide option selected, you will only be moving yourself and 
not anyone else in the session. 

Step 3: From the Tools menu, select End the WebTour to close the 
WebTour window and end the WebTour session. 

 
To use a quiz manager: 
(The ClassLive Quiz Manager feature is only available to ClassLive Pro users. Check with your 
administrator about which version of ClassLive you are running.) 

Step 1: From the Window menu, select Quiz Manager. The Quiz window 
opens. 

Step 2: Click on the Create a new quiz button. The Design tab panel 
opens. Type the name of the quiz in the top right-hand corner in the 
New quiz textbox.

Step 3: Click on the Add a new question to the end of the quiz button. 
The New question textbox opens. Type the question into the New 
question... textbox. 

Step 4: To enter multiple-choice responses, click the Add a multiple 
choice answer to the current question button for each response 
and type the responses in the textbox. 

Step 5: Click on the Add a new question to the end of the quiz button to 
enter additional questions. Use the forward and back arrows to 
navigate through the questions you just created. 

 
To use the graphing calculator: 

Step 1: From the Window menu, select Graphing Calculator. The 
graphing calculator opens in a separate window from your regular 
ClassLive session. You and your students can use the graphing 
calculator to create visual representations of equations. This 
includes plotting and evaluating functions, selecting and displaying 
points, setting and displaying region and grid spacing, and sending 
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and receiving plotted graphs.

Step 2: Click on any of the graphing calculator tools accordingly. For more 
detailed information on how to use the graphing calculator features, 
refer to the User Guide for moderators found on the training page 
provided by Elluminate, Inc.

Step 3: To close and end your graphing calculator session, from the 
Window menu, de-select Graphing Calculator. The Graphing  
Calculator window closes. 

Frequently Asked Questions 
Since the ClassLive feature might be new to you, we've compiled a list of frequently asked 
questions. Check the list below to see if your questions have already been asked and answered.  
 
Note: As a stand-alone tool, ClassLive includes a training page with video tutorials and additional 
documentation provided by Elluminate, Inc. On the support page you will find a link to Technical 
Support which includes additional FAQs.  

Where can I find specific information about the ClassLive features?  
As a stand-alone tool, ClassLive includes a training page with video tutorials and additional 
documentation provided by Elluminate, Inc. 

How can I enlarge the view of the text messaging area?  
The Chat window in ClassLive is resizable. To enlarge the window, on the View menu de-select 
Layout Locked (selected by default). You can resize the window diagonally, by clicking on the 
corner of the Chat window and dragging your mouse. You can also resize the window vertically 
and horizontally.  

How can I see the entire whiteboard area?  
There are two ways you can maximize the whiteboard viewing area. First, click the "maximize" 
button in the top-right corner of your session window. This maximizes the entire ClassLive 
session window so that the session fills your entire screen. Second, from the View menu, de-
select Layout Locked (selected by default), and then double-click on the title bar of the 
whiteboard. This also expands the whiteboard area to fill the entire screen. Double-click again in 
the title bar of the whiteboard to return to the original view.  

How do I delete an object from the whiteboard?  
Select the object you would like to delete and Right-click to open the context menu. Select Delete 
Object(s). The selected objects clear from the whiteboard. Note: To delete all objects on the 
whiteboard, click the Eraser button on the whiteboard toolbar. A confirmation message opens. 
Select All Objects to delete all content on the whiteboard.  

How can I change the color of my drawing tool?  
Each time you select a drawing tool on the whiteboard toolbar, editing attributes display in the 
"Quick Editor" located at the bottom of the whiteboard screen area. The editing attributes change 
according to the selected drawing tool. Editing attribute options can include color palette, font, 
size, and style. To change the color of your drawing tool, click on a color in the "Quick Editor" 
color palette and begin to draw in the main area of your whiteboard screen. Your drawing 
displays in the selected color.  

I'm trying to Move, Copy, or Delete an object. How do I select the object and complete the 
action?  
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Select the object you want to Move, Copy, or Delete. With the object selected, Right-click to open 
the context menu and select Move, Copy, or Delete Object(s).  

What objects can I modify and edit on the board?  
You can modify and edit all objects on the whiteboard.  

What happens if I select Follow Moderator?  
The Follow Moderator button, when selected, forces students to see only the changes you make 
to the whiteboard. This feature is useful when you want to prevent students from having the ability 
to access other ClassLive tools within a session while you are demonstrating a problem or 
leading a Web tour.  

How do I draw a circle or a square?  
Use the drawing tools on the whiteboard toolbar to create objects. To draw a circle, click on the 
Draw an Ellipse on the screen button. To draw a rectangle, click on the Draw a Rectangle on 
the screen button. We have created a table to help you understand how to use the whiteboard 
drawing tools.  

How do I fill an object like a circle or a square?  
Use the drawing tools on the whiteboard toolbar to create filled objects. To draw a Filled Circle, 
click on the Draw a filled ellipse on the screen button. To draw a filled rectangle, click on the 
Draw a Filled Rectangle on the screen button. We have created a table to help you understand 
how to use the whiteboard drawing tools.  

I made a mistake on the board. How can I remove or fix it?  
To correct a mistake or "fix" content on the whiteboard, simply select the object and Right-click to 
open the context menu. Select Delete Object(s) to remove the object.  

How can I print or save the text message portion of the ClassLive discussion? 
To print a text message log, you must first save the text message as a text file. From the File 
menu, select Save, and then select Chat Conversation. In the Save Chat Conversation 
window, select a file name and the folder to which you want to save the file, and then click Save. 
The suffix .txt is added to the filename. You can use Notepad, WordPad or any word processing 
application to open the text file and print it.  

How can I save a whiteboard screen in the ClassLive discussion?  
From the File menu, select Save, and then select Whiteboard. The Save File window opens. 
Navigate to and open the file folder to which you want to save the whiteboard. Type a file name in 
the File Name textbox and scroll through the Files of Type drop-down menu to select a file 
format. Click Save to close the Save File window. The Select Screens window opens. Select 
whether you want to save all the screens in the Current Screen Group, only the Current Screen, 
or the Selected Screens. If you select Selected Screens, an explorer window opens showing all 
available screens. Select the screens you want to save from the explorer window. Use the Shift or 
Ctrl (Command) key to select multiple screens, and then click OK.  

How can I print a whiteboard screen in the ClassLive discussion?  
From the File menu, select Print, and then select Whiteboard. The Select Screens window 
opens. Select how you want to print the screen. If you select Selected Screens, an Explore and 
Select Screens panel displays in the Select Screens window listing all of the available screens. 
Select the screens you want to print from the list. Use the Shift or Ctrl (Command) key to select 
multiple screens, and then click OK. The Page Set-up window opens. In the Page Set-up and 
Print windows, specify your preferences and click OK.  

Note: Protected Whiteboard screens do not print.  
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Do I have to minimize my shared application if I want to return to the ClassLive session?  
No, ClassLive's Application Sharing feature allows you to open applications within the main area 
of the whiteboard. When you first login as the instructor, you automatically have the permission to 
begin sharing your desktop. To start Application Sharing, on the Tools menu select Application 
Sharing, and then select Host Applications. As a stand-alone tool, ClassLive includes a training 
page with video tutorials and additional documentation provided by Elluminate, Inc.    

Note: The ClassLive Application Sharing feature is only available to ClassLive Pro users. Check 
with your administrator about which ClassLive version you are running. 

Are my ClassLive sessions archived? How can I view an "old" session?  
All ClassLive sessions are archived and can be viewed by both instructors and students. On the 
Chat tab, you can access an archived session from the ClassLive link in your course. Locate the 
Session Archives section on the page to see a list of all archived ClassLive sessions in the 
current course.  

How do I broadcast live video?  
Before you can broadcast video, you must enable video support. To enable video support, from 
the Tools menu, select Video, and then select Enable Video Camera Support. A check mark 
indicates video is not enabled. As a stand-alone tool, ClassLive includes additional information 
about audio and video features on the training page provided by Elluminate, Inc. 

Note: The ClassLive WebCam (video) feature is only available to ClassLive Pro users. Check 
with your administrator about which ClassLive version you are running. 

Can I save my ClassLive sessions?  
Yes, you can save the whiteboard screens from every session. If you have content you would like 
to save from a breakout room, you must copy the content into the main whiteboard screen to 
capture the information in a saved session.  

How do I exit the ClassLive Session?  
To exit the ClassLive session, click Exit from the File menu. 

Can I save the quiz I created in Quiz Manager?  
Yes! You can save quizzes created in Quiz Manager; however, quizzes created within a 
ClassLive session are saved in XML format and are not connected to the course Gradebook. If 
you want your students' quiz results stored in the course Gradebook, you must create the quiz 
within the main course (outside of ClassLive).  

Note: The ClassLive Quiz Manager feature is only available to ClassLive Pro users. Check with 
your administrator about which ClassLive version you are running. 

Viewing ClassLive archives 
All ClassLive sessions are archived and can be viewed by both you and your students. ClassLive 
sessions are archived by session name (if you named the session when you closed out of it). If 
you didn't give the session a name, the session is archived by the date and time the session took 
place. As a professor, you can create a folder system for your ClassLive archives to make it easy 
for you and your students to locate and view previous sessions.  
 
To view a ClassLive archive: 

Step 1: Click the Chat tab at the top of your course. 
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Step 2: Click the ClassLive link and then locate the Session Archives 
section on the page to see a list of archived ClassLive sessions. 
Remember that ClassLive sessions are listed by name (if they have 
a name assigned to them); otherwise, they're listed by date and 
time.  

 

Sharing Documents 
The Doc Sharing tool lets you and your students upload and download documents, images, 
spreadsheets, and HTML pages. Students can download documents you provide—or other 
students' documents—and then view, revise, or re-create those documents. They can then 
upload their changes for the entire class to view. Both you and your students have access to 
shared files, but only instructors can delete files. As an instructor, you can also create and edit 
Document Sharing categories. 
 
To ensure that students can view each other's files, make sure that all students are using the 
same file format. For example, if a student is unable to view MS Word 2000 files, encourage your 
class to post their documents in another common format. 
 

Uploading Files 
Uploading a file with the document sharing tool allows you to share files and documents with your 
class. You can upload files for your own viewing, or you can choose to share the files with the 
entire class.  
 
Before you begin, we suggest saving the file to be uploaded to your computer's desktop or 
another familiar folder, so that it is easy to locate when you begin to upload it. If you choose to 
attach a file type that is not supported by the system, you’ll receive a pop-up message displaying 
currently accepted file types. 
 
If you have a file with a different extension that you would like to upload into Doc Sharing, simply 
zip it and then upload the .zip file so your students can access it. 

 
Note:  If you're creating a course that must meet Section 508 Accessibility Requirements, you'll 
need to make sure that any file you upload to your course meets the requirements. To see 
specific 508 requirements or for more information, see the Help topic under Course Creation 
called Accessibility Requirements or go to http://www.access-
board.gov/sec508/guide/1194.22.htm . 

 
 
To upload a file:  

Step 1: Click the Doc Sharing tab at the top of your screen. This opens the 
main Document Sharing page.

Step 2: If you’ve created groups or added Document Sharing categories 
within your course, you will need to select a Doc Sharing view from 
the Select View list and then click Go. The Select View drop-down 
list allows you to upload or assign files to a specific group or to a 
specific category.    
 
If there are no groups or categories within your course, the Select 
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View drop-down list is not displayed...you'll simply see a list of files 
available for downloading. 
  

 
Note:  If you want to assign the document to a group or to a specific 

category, you must select that view from the drop-down list before 
you upload the file. If you do not select a view, the document is 
uploaded to the default general area. 

Step 3: Click the Upload New File link. 

Step 4: Choose to make the file viewable to you only, or to share the file 
with the entire class. Select one of these options next to Sharing. 
 

Tip: If you want your students to be able to view the file you uploaded, 
you must click the radio button next to "share file with entire class."  

 

 

Step 5: Click the Browse button to locate the file you want to upload. Once 
you have located the file, click Open or OK, depending on your 
Browse window. The file name appears in the File to Upload box.  

Step 6: If you are uploading a zipped file, you can have the system "unzip" 
the file after it is uploaded. To unzip the file upon upload, check the 
Unzip Zip File checkbox. 

Step 7: To upload your file, click Upload File at the bottom of the screen.  
Step 8: After you click Upload File, you will be prompted to enter a 

description of the file. The description you enter is what users will 
see in the Doc Sharing list. The description should tell users what to 
expect when they open the document. 
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Downloading Files  
Downloading a file with the Document Sharing tool allows you to save a file to your hard drive or 
other location for future viewing, editing, etc. Students can use the Doc Sharing tool to download 
files from the course as well. As an instructor, you can also see which students have downloaded 
a particular file and when the file was downloaded.  
 
To download a file:  

Step 1: Click the Doc Sharing tab at the top of your screen. This opens the 
main Document Sharing page.

Step 2: If you’ve created groups within your course or added categories, 
you’ll need to select a Doc Sharing view from the Select View list 
and then click Go. The Select View drop-down list allows you to 
download files that were uploaded to a specific group or category.   
 
If there are no groups or categories within your course, the Select 
View drop-down list is not displayed...you'll simply see a list of files 
available for downloading.

Step 3: If there are files available for download in the view you selected in 
Step 2, these files are displayed in the File/Description list, along 
with the owner of the file, the date the file was uploaded, the file 
size, whether the file is shared, and a record of how many times the 
file has been downloaded. As an instructor, you’ll also have the 
option of deleting the file from the Doc Sharing tab.   
 

 
Step 4: From the File/Description list, click the file you want to download.  

 
If you’re using Internet Explorer as your browser, the file will open in 
a new browser window. (If you’d rather save the file directly to your 
hard drive, right-click on the file in the File/Description list and 
select Save Target As from the pop-up menu that appears.)  
 
If you’re using Netscape as your browser, a File Download window 
appears. Select Save this file to disk and click OK. A Browse 
window opens in which you can select a location for the saved file. 
Click OK in this window to save the file. 

 
To view a file’s download history:  

Step 1: Locate the file for which you're interested in viewing the download 
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history. 
Step 2: In the Download History column, the number of times each file has 

been downloaded displays. For more specific download history 
information for a certain file, click the # of downloads link for the 
file you're interested in. 

Step 3: A Download History window opens which displays the names of 
users who have downloaded the file and the date on which they 
downloaded the file. Click the Close Window link to close the 
Download History window and return to the Doc Sharing tab. 

 

Adding and Editing Document Sharing Categories 
Organizing shared documents by category makes it easy for you and your students to sort and 
view individual entries. For example, it's helpful to create subject categories (Management, 
Accounting, Operations), team categories (Group A, Group B), or assignment categories (Week 
One, Week Two, etc.). Only instructors can create Doc Sharing categories. 
 
To create and edit categories:  

Step 1: Click the Doc Sharing course tool at the top of your screen. 
Step 2: Click Add/Edit Categories.

Step 3: To add a new category, enter a title for the category and click Save 
Category or Save and Add Another Category.

Step 4: To edit an existing category, select the category from the Select 
Category drop-down list. Rename the category, and click Save 
Changes. 

Step 5: To delete an existing category, select the category from the Select 
Category drop-down list. Click Delete. 

 

Editing Shared Documents 
As an instructor, you can edit or delete shared documents. You can also determine whether 
students' documents are shared with the entire class. Note that when you edit and re-upload a 
document, the original document remains in the Doc Sharing list; re-uploading simply creates a 
second (modified) file with the same name, allowing you to see each iteration of the document.  
 
To edit a file:  

Step 1: Click the Doc Sharing tab at the top of your screen. 

Step 2: Download the file you want to edit to your hard drive (or other 
location). Refer to the Downloading Help section of this document 
for information on downloading files. 

Step 3: Make any changes to the file. Make sure and save your work.  
Step 4: Upload the file to the course again, using the same file name. The 

new, modified file will not replace the existing file, so you’ll need to 
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delete the original file from Doc Sharing if you don’t want two 
versions of the file showing up. See Uploading Files if you need 
information on uploading files to courses. 

 
To share (or unshare) an uploaded file:  

Step 1: Click the Doc Sharing tab at the top of your screen and select a 
view/category.  

Step 2: Locate the file you want to share (or unshare). 

Step 3: On the right-side of the screen, click Yes or No to share the file. If 
you click Yes, the file will be visible to your students. If you click No, 
only you will be able to view the file. The current shared status of 
the document displays in capital letters.  
 
You can "unshare" a file a student has shared, although the file will 
remain visible to the student who shared it (the owner). 

 
To delete an uploaded file:  

Step 1: Click the Doc Sharing tab at the top of your screen and select a 
doc sharing view. 

Step 2: Locate the file you want to delete and click Delete on the right side 
of your screen.  
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Using the Dropbox 
The purpose of the Dropbox feature in your course is to provide a central location where you and 
your students can submit and retrieve assignments and graded activities. Think of the Dropbox as 
a virtual "Inbox" and "Outbox" for course assignments: 
 

 You pick up or retrieve submitted assignments from your students in your Inbox  
 You return or send graded assignments back to your students in your Outbox  

 

 
 
Your Dropbox/Inbox is also linked directly to the Gradebook, which makes it easy to open an 
assignment, grade it, and then record the student's grade directly into the Gradebook—all from 
one place. Students can open a graded item from either the Dropbox or from the Gradebook and 
see their grade for that item. You can also attach files and documents to assignments when you 
return them to students. If you choose to attach a file type that is not supported by the system, 
you’ll receive a pop-up message displaying currently accepted file types. 
 
Note: Before students can submit an assignment to the Dropbox, there needs to be a Dropbox 
basket created for that Content Item. Only Content Items for which you have set up Dropbox 
baskets will display in the Dropbox submission area for students. You can create a Dropbox 
basket for a Content Item when you first add the Content Item to the course, or you can add the 
Dropbox basket for the Content Item later. See the Help topic Creating a Dropbox basket for 
more information.  
 
 

Creating a Dropbox basket 
Before students can submit an assignment to the Dropbox, there needs to be a Dropbox basket 
created for that Content Item. Only Content Items for which you have created Dropbox baskets 
will display in the Dropbox submission area for students. Students select the appropriate Dropbox 
basket and then submit their assignment to that basket.  
 
You can create a Dropbox basket for a Content Item when you first add the Content Item to the 
course, or you can add the Dropbox basket for the Content Item later.  
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To create a Dropbox basket for a new Content Item: 

Step 1: Select the Course Home page or the Unit to which you're adding the 
new Content Item.

Step 2: Click the Author tab and then click Add Content Item.

Step 3: Proceed to add the Content Item just as you would normally (for 
information on adding Content Items, see the Help topic Adding 
Content in the Course Content section). 

Step 4: When it's time to save or "add" the Content Item, click Add to Unit 
& Create Dropbox Basket. This will add the new Content Item to 
your Course Home page or Unit AND automatically create a 
Dropbox basket for the new Content Item. 

 
 
To create a Dropbox basket for an existing Content Item: 

Step 1: Locate the Content Item within your course for which you want to 
add a Dropbox basket.

Step 2: Click the Author tab.

Step 3: Click the Toolbox button in the top-right corner of your screen.  

Step 4: Click Create Dropbox Basket. A Dropbox basket is created for the 
selected Content Item. 

Note:  If a Dropbox basket has already been created for the selected 
Content Item, this link will read Delete Dropbox Basket instead. 

 
Once a Dropbox basket has been created for a Content Item, students will be able to submit 
assignments to the basket in the Dropbox submission area. Dropbox baskets are always named 
after the Unit and the Content Item name (i.e., Unit 4: Readings). You can, however, rename or 
edit Dropbox baskets.  
 
 

Editing or deleting a Dropbox basket 
By default, all Dropbox baskets are created and named after their Unit and Content Item name 
("Unit 2: Readings" for example). This is helpful for students in the Dropbox submission area as 
they submit an assignment--they can easily associate their assignment with the correct Dropbox 
basket. However, you can rename Dropbox baskets, and you can delete a Dropbox basket 
entirely. 
 
To edit a Dropbox basket name: 

Step 1: Click the Dropbox tab in your course.

Step 2: Select the Dropbox basket you want to rename from the Basket 
drop-down list and click Go.

Note: If you select View All from the drop-down list, you will be able to 
edit the names of all your Dropbox baskets at once. 
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Step 3: At the bottom of the page that displays, click Edit Dropbox Basket 
Name. 

Step 4: Enter a new name for the Dropbox basket in the Name field and 
click Save Changes. Students will now need to select this new 
name from the Dropbox submission area to submit assignments to 
this Dropbox basket. 

 
In order to delete a Dropbox basket, the basket must be EMPTY. That is, you cannot delete a 
Dropbox basket if there are items currently in the Inbox or Outbox. Similarly, you cannot delete a 
Content Item if the Content Item includes a Dropbox that has items in its Inbox or Outbox.  
 
 
To delete items in a Dropbox basket: 

Step 1: Click the Dropbox tab in your course.

Step 2: Use the Search by Dropbox Basket drop-down list to locate the 
Dropbox you'd like to delete. Any items currently in the Dropbox 
basket you selected display in your Inbox and Outbox.

Step 3: Delete each item, one by one, by opening the item and then clicking 
Delete in the bottom right corner of the window that opens. Note 
that you may have to delete several responses within a single 
Dropbox item before you can delete the item entirely (for example, if 
you and the student have sent the assignment back and forth).  

Step 4: Once the Dropbox basket is completely empty (there are NO 
assignments in either the Inbox or the Outbox), you can delete the 
Dropbox basket itself. 

 
 
To delete a Dropbox basket: 

Step 1: Click the Dropbox tab in your course.

Step 2: Select the Dropbox basket you want to delete from the Basket 
drop-down list and click Go.

Step 3: At the bottom of the page that displays, click Delete Dropbox 
Basket. Click OK to permanently delete the Dropbox basket. 

Note: You can also delete a Dropbox basket from the Author view of a 
particular Content Item. In Author view, locate the Content Item, 
click the Toolbox button in the top-right corner, and then click 
Delete Dropbox Basket. 

 
 

Linking course content to the Dropbox 
You can create links within your course that go directly to the Dropbox so students know exactly 
how and where to submit each individual assignment. Remember that you need to create a 
Dropbox basket for a Content Item before students will be able to submit assignments to that 
Dropbox basket.  
 



Copyright © 2008 eCollege 
Page 131 

To create a link from a Content Item to the Dropbox: 

Step 1: Locate the content item within your course and click the Author tab. 
Note: Dropbox baskets cannot be created for Exams, Threaded 

Discussions, or Custom Content Item types.

Step 2: Click the Link button on the Visual Editor (or the Add Link link in 
the Text Editor for Mac and Netscape users). The Link Wizard 
opens. 

Step 3: Select Link to Area in Course in the Select Type of Link drop-
down list and then click Go. 

Step 4: From the options that display, select Course Tools and click Go. 

Step 5: In the drop-down list that displays, select Dropbox. 
 

Step 6: Enter your link text in the Link Text field. This is the text that your 
students will actually click on to access the Dropbox and submit 
their assignment. 

Step 7: Click Add Link. The link is added to the Content Item. When 
students view this Content Item, they will be able to simply click the 
link text you specified and they will be taken directly to the Dropbox. 
They will still need to specify which Dropbox basket they're 
submitting work to, however. 

 

Viewing your Dropbox 
When students submit work to the Dropbox, their assignments appear in your Inbox. Another 
easy way to tell if students have turned in work is to simply check the What's New section of your 
Course Home Page. When any student submits an assignment to the Dropbox, the What's New 
feature will notify you that a new assignment has been turned in. You can access the assignment 
from the What's New feature, or you can view the assignment from the Dropbox tab.  
When you click the Dropbox tab, you'll see several sorting or viewing options: 
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 sort by Basket  
 sort by student 

 
If you choose to sort your Dropbox by Basket, you'll see all Inbox and Outbox items for a 
particular assignment only--regardless of who submitted it. For example, if you were to select 
"Unit 1: Questionnaire" from the Basket drop-down list and then click Go, you would see in your 
Inbox all assignments that had been submitted to the Unit 1: Questionnaire Dropbox only—no  
other assignments would display, and the assignments that did display would come from any 
student who had submitted work to this particular Dropbox basket.  
 
If you choose to sort your Dropbox by Student, you'll see all Inbox and Outbox items for one 
student only. For example, if you were to select "Jenny Petersen" from the Student drop-down 
list and then click Go, you would see in your Inbox and Outbox all assignments that had been 
submitted by Jenny Petersen, regardless of the Dropbox basket they were originally submitted to. 
No other assignments from other students would display.  
 
Regardless of the sort option you choose, assignments that your students have submitted to you 
to be graded will appear in your Inbox, and assignments that you have graded or reviewed and 
returned to your students appear in your Outbox. You can further refine or sort your Dropbox 
contents by using the additional Sort options in the top right corner of your Dropbox screen--
within both views you can also sort by Submitted Date; within the individual views you can also 
sort by Author or by Basket.  
 
 

Grading and returning submitted work 
The Dropbox makes it extremely easy to grade assignments and return the graded work to 
students--you can open and review assignments from the Dropbox and then assign a grade right 
from there! There's no need to go to the Gradebook. 
 
Note: You can only enter grades through the Dropbox for assignments that you have set up in 
the Gradebook as "gradeable." To make items gradeable, click the Gradebook tab, go to Setup 
Gradebook, and check the box next to the individual Content Item to identify it as "gradeable."  
Content Items that you have not identified as being "gradeable" will display "N/A" in the 
Numeric/Letter Grade columns of your Dropbox and will not have Numeric/Letter Grade fields in 
the Gradebook Details window.  
 
When you review a submitted assignment, there are (usually) two parts to the student's 
submission:  
 

 information, comments, or notes the student entered at the time the assignment was 
submitted, and  

 any attachments or files the student submitted (these are usually the assignment itself) 
 

As a result, there are basically two "parts" or views for student submissions: 1) the Gradebook 
Details window (where you'll view students' comments and actually enter grades); and 2) 
attachments from students.  
 
 
To open the Gradebook Details window and assign a grade: 

Step 1: Use the sorting options on the Dropbox tab to locate the assignment 
you want to grade (i.e., sort by Dropbox basket or by student). 
Submitted assignments awaiting your review appear in your Inbox. 
If you've already graded an assignment, the numeric and/or letter 
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grade display to the right of the assignment name.

Step 2: Click the assignment name in your Inbox. The Gradebook Details 
window opens. 
 

 

Note:  If a student submission includes an attachment, you'll see an 
"attachment" icon next to the assignment name in your Inbox. Hold 
your mouse over the icon to display the file name of the attachment. 
 
To open the Gradebook Details window, make sure you click on 
the assignment name rather than the attachment icon (if the 
assignment includes an attachment). If you click the attachment 
icon, the attached file will open in a separate browser window. You 
can always access the attachment from the Gradebook Details 
window. 

Step 3: In the Details section of the Gradebook Details window, you can 
see the name of the student who submitted the assignment, the 
date and time the assignment was submitted, whether there are 
attachments with the submission, and any comments or notes the 
student may have entered for you. 

Note: You can view attachments here by clicking on the attachment icon. 
Note that you can only view the file; you cannot make changes or 
comments within the attachment. You can, however, attach a file to 
your response in the Gradebook Details window (see below). 

Step 4: After reviewing the attachment and/or the student's comments, 
enter a numeric and/or letter grade for the assignment in the 
Gradebook Details window. Remember that you'll only see the 
grading options if you've identified the Content Item as "gradeable" 
in your Gradebook. 

Step 5: Enter any comments to the student in the Comments text box. For 
example, you may want to include why you assigned the grade you 
did, or you may want to direct the student to areas for additional 
study. 
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Step 6: If you'd like to attach a file to your review and return it to the 
student, click Add Attachments and follow the instructions on-
screen. 

Step 7: At this point, you have several options:  

• Click Save to save the grade WITHOUT returning the 
assignment to the student. If you select this option, the 
grade will be saved but the assignment will remain in your 
Inbox and the student will not be able to see the grade. You 
can return the assignment to the student at a later time 
through the main Inbox screen. Simply check the Return 
checkbox next to the assignment and then click Save 
Changes. This option is helpful if you want to grade ALL 
student assignments first, and then return them to your 
students at the same time.  
 

• Click Save and Return to Student to save the grade and 
return the assignment to the student. In this case, the grade 
is saved AND the assignment is returned to the student 
(i.e., the assignment moves from your Inbox to your Outbox 
and the student is able to see the assignment in his/her 
Inbox).  
 

• Click Cancel to close the Gradebook Details window 
without saving any of your changes. 

Note: Any grades you save through the Dropbox are passed through to 
your Gradebook as well. That is, if you assign and save a grade 
using the Dropbox, you do not need to transfer the grade to the 
Gradebook. 

 
There are several ways you can return graded assignments to students. You can return each 
individual assignment as you grade it, or you can grade all assignments and then return them all 
at once. 
 
To return a single graded assignment: 

Step 1: Click on the name of the assignment you want to grade and return 
in your Inbox. The Gradebook Details window opens.

Step 2: Enter a grade for the assignment in the Numeric and/or Letter 
Grade field. 

Step 3: Click Save and Return to Student. The grade is saved in your 
Gradebook and the assignment is returned to the student's Inbox 
(and moves to your Outbox). 

 
 
To return multiple graded assignments at the same time: 

Step 1: Click on the name of the assignment you want to grade and return in 
your Inbox. The Gradebook Details window opens for that item. 
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Step 2: Enter a grade for the assignment in the Numeric and/or Letter Grade 
field. 

Step 3: Click Save. The grade is saved in your Gradebook, but the 
assignment remains in your Inbox and is NOT shared with the 
student. 

Step 4: Continue to grade additional assignments in the same way, selecting 
the Save option in the Gradebook Details window. 

Step 5: When you're ready to return all the assignments to your students, go 
to your Inbox and check the Return checkbox next to each 
assignment you want to return. 
 

 

Step 6: Once you've selected the items to return, click the Save Changes 
button. This will return the graded assignments to the student(s) and 
move the assignments from your Inbox to your Outbox. 

 
 
 
 

Using Journals 
The Journal is a place where students can make notes and record thoughts. As an instructor, you 
can also use the journal as an assignment area. For example, you can post articles or questions 
in students’ journals and then require students to respond to whatever you post in their journals.  
 
Students have the option of sharing their journal entries with you. As an instructor, you can read 
and modify entries that students choose to share. You can also create your own entries in 
students' journals.  
 
The Journal is accessed from the Dropbox tab—simply click the Journal button.  
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Adding Journal Entries 
Both you and your students can use the journal tool to make journal entries. Remember that 
students can designate entries as private (viewable only by the student), or as shared.  
 
To add an entry to a student's journal: 
 

Step 1: Click on the Dropbox tab at the top of your screen. 

Step 2: Click the Journal button.  

Step 3: Select a student from the drop down menu. Then click Go to view that 
student's journal. The student's journal entries appear in a list.  
 

 
 

Step 4: Click Add New Entry. A new screen opens. 
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Step 5: Enter a title for your entry, and type your entry in the space provided.  
 
Tip: When adding an entry to a student's journal, make sure you select Share 
Entry with Instructor. If you select Private Entry, the student will be able to 
view your entry, but you will no longer see it. 
 
Step 6: Click Add Entry.

 

Viewing Journal Entries 
You can view all of a student's journal entries at once, or you can view one entry only. 
  
To view journal entries: 
 

Step 1: Click on the Dropbox tab at the top of your screen. 

Step 2: Click the Journal button.  

Step 3: Select a student from the drop-down menu. Then click Go to view that 
student's journal. The student's journal entries appear in a list. For 
each entry, you'll see the names of each person who has modified the 
entry, and the date on which the last modifications were made. If both 
you and the student have modified the entry, both names will appear.  

Step 4: Click the plus sign next to a single entry to "expand" and view that 
entry.  

Tip: Remember, you can only view entries that the student has marked as 
shared. 

Step 5: To view all entries at once, click Expand All in the upper right corner.  

Step 6: To close all entries when they are all expanded, click Collapse All.  
 

 
Editing Journal Entries 
As an instructor, you can edit any existing journal entry that a student has marked as shared. 
Students can make additions and corrections to their own journal entries, although they cannot 
delete their journal entries.  
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To edit an existing journal entry: 
 

Step 1: Click the Dropbox tab at the top of your screen. 

Step 2: Click the Journal button.  

Step 3: Select a student from the drop-down menu. Then click Go to view that 
student's journal. The student's journal entries appear in a list.  

Step 4: Click the plus sign next to the entry you wish to edit. This will expand 
that entry for viewing.  

Step 5: Click Edit in the lower left corner. 

Step 6: Make any comments or corrections in the journal entry. 
 
Tip: When you edit a student's journal entry, make sure you select the Share 
Entry with Instructor option. If you select Private Entry, the student will be able 
to view your entry, but you will no longer see it. 
 
Step 7: Click Add Entry. 

Creating a Course Webliography 
The Webliography course tool lets you and your students work together to create an annotated 
bibliography of world wide web sites that are relevant to your course.  
Both you and your students can submit sites to the Webliography. Students can greatly increase 
the knowledge capital of the course by submitting web sites they have found.  
 
Some instructors have created an assignment in the first week of class that asks students to find 
three web sites relevant to a specific topic and then submit them to the Webliography. The next 
week, students are asked to evaluate three of the web sites that other students posted. This 
exercise is an effective way to teach students the art of researching on the web. 
 
You can sort Webliography entries by the date they were submitted, by category, or by the 
person who submitted the entry.  
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Adding Categories 
Organizing Webliography entries by category makes it easy for you and your students to sort and 
view individual entries. For example, it's helpful to create subject categories (Management, 
Accounting, Operations), team categories (Group A, Group B), or assignment categories (Week 
One, Week Two, etc.). Only instructors can create Webliography categories.  
 
To create and edit categories: 

Step 1: Click the Webliography course tool at the top of your screen.  
Step 2: Click Add/Edit Categories just above the Entries list.

Step 3: To add a new category, enter a title for the category and click Add 
Category. 

Step 4: To edit an existing category, select the category from the Select 
Category drop-down list. Rename the category, and click Save 
Changes.  

Step 5: To delete an existing category, select the category from the Select 
Category drop-down list. Click Delete. 

 

Adding Webliography Entries 
Both you and your students can add web site entries to the Webliography.  
 
To add an entry: 
 

Step 1: Click the Webliography course tool at the top of your screen.  

Step 2: Click Add New Entry. 

Step 3: Enter a title for your web site and assign the site to a category from 
the Category drop-down list. Only those categories you've created for 
your course will appear in the drop-down list. 

Step 4: Enter the URL (address) for the site. Make sure you enter the address 
exactly as it appears when you view the site (it's a good idea to copy 
and paste the URL).  

Tip:  If you're creating a course that must meet Section 508 Accessibility 
Requirements, remember that any URL you link to within your course 
should also be Section 508 compliant. For more information about 
these requirements, see the Help topic under Course Creation called 
Accessibility Requirements or go to http://www.access-
board.gov/sec508/guide/1194.22.htm . 
 

Step 5: Enter a short description of the web site—what students will find if 
they go there. You can also enter the site author (content author) and 
the date the content was created (if available).  

Step 6: Click Submit to submit your entry.
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Course Creation Tips 
 
Because this whole online course creation process may be relatively new to you, we've included 
some Course Creation Tips in this section that may help you as you develop your course.  
 

 The Visual Editor will show you how to format content within your course. It also 
includes help for using and accessing the Math Equation Builder, as well as general tips 
for using the Visual Editor.  
 

 Adding links, images, and files shows you how to use the Add Link/Image wizard to 
add different file types and links to your course, as well as create links within your course 
to course tools and content.  
 

 Math Equation Editor shows you how to use this powerful tool to create complex 
mathematical equations within your course.  
 

 Accessibility Requirements gives you an overview, as well as specific online 
resources, for ensuring that your course meets Section 508 requirements.  
 

 Referencing the HTML guide explains how to launch and use an online HTML guide 
that will help you design your course.  
 

 FAQs displays a list of Frequently Asked Questions. Check here to see if your questions 
have already been asked and answered!  

 
 

 
Using the Visual Editor 
As an online course author, you should be able to create, modify, and format your course content 
whether you're familiar with HTML or not. Toward this end, we've tried to make formatting your 
course content as easy as editing with a simple word-processing document. The tool that can 
help you do this is the Visual Editor.  
 
The Visual Editor is built into the course authoring mode and allows you to format text for display 
on the Web without any HTML knowledge. The Visual Editor is a toolbar that can be accessed 
above any standard authoring text box--you'll see the Visual Editor throughout your course as you 
author. Because it mirrors many familiar word-processing toolbar buttons, the Visual Editor is 
easy to use.  
 
The Visual Editor displays as its own toolbar above any text box when you are authoring various 
sections of your course (however, see the Mac/Netscape help topic in this section if you're using 
either a Mac or Netscape). It is best described as a simple word-processing toolbar with the 
following functions:  
 

 Cut, Copy, Paste  
 Undo/Redo  
 Align (left, center, right)  
 Numbered List/Bulleted List  
 Decrease Indent/Increase Indent  
 Add Link  
 Insert Image  
 Spell Check  
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 Equation Editor  
 Font Style, Font Size, Font Color  
 Bold, Italic, Underline  
 Tables 

 
 

 
 
 
Specifically, you can use the Visual Editor to change the font, size, alignment, and color of text; to 
create bulleted and numbered lists; and to add emphasis like bold, italic, and underlining, and to 
create tables. You can use the Visual Editor's Link button to add links to external files and 
images, websites, and to link from one area of your course to another. You can use the Image 
button to add graphics and images to your course. Finally, you can access the Equation Builder, 
which will help you create complex mathematical equations and formulas to share with your 
students.  
 
Review the section in this document called Formatting Course Content: Using the Visual Editor 
(under Course Content) for more specific information about using this versatile tool.  
 

Adding Links and Images with the Visual/Text Editor 
There are many places in your course where you may want to add links to external files and web 
pages or add files directly into your course. You may also want to add links from one section of 
your course to another section, like from the Gradebook to a specific area in the course where a 
graded item was covered, or from a threaded discussion topic to a related content item, for 
example. There's a simple process for adding links, and it's the same process no matter where 
you are in your course. The Link Wizard will help you add links to external files, web pages, and 
to tools and content items within your individual course.  
 
You can access the Link or Image Wizard from anywhere the Visual Editor (or Text Editor, for 
Mac and Netscape users) is available in your course. Simply click the Link or Image button on the 
toolbar: 
 

 
 
The Visual Editor is available in the Author view for most content items. Once you click the Link 
or Image button, the Wizard will step you through the process of adding, uploading, or linking to 
files and course content (see below).  
 
Note:  If you're creating a course that must meet Section 508 Accessibility Requirements, you'll 
need to make sure that any file you upload to your course meets the requirements. To see 
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specific 508 requirements or for more information, see the Help section called Accessibility 
Requirements or go to http://www.access-board.gov/sec508/guide/1194.22.htm . 
 
To add a link to an existing file or image:  

Step 1: Click the Link button on the Visual Editor toolbar to link to a file. 
Click the Image button to insert an image.  

 
If you don't see the Visual Editor toolbar, you probably can't add 
links to that particular element. When you click the Link (or Image) 
button, the appropriate Wizard opens

Step 2: From the drop-down list, select the type of link you would like to 
add. To link to a document or image, select from either of the 
following two options:  
 

• Link to a File or Document  
• Link to an Image  
 

If you are linking to an Image File or a Document File, you will need 
to send that file from your computer to the computer that houses 
your course at eCollege so that students can link to the file. This 
process is called Uploading the file. If you have not already 
uploaded the file, select the button that will allow you to upload the 
file now.  

 

Tip: Uploading a file means transferring the file from your computer 
to your course. All of the information in your course is stored on a 
computer at eCollege called a server, which provides the 
information whenever someone accesses the course from their 
computer.  
 
You can upload files with any of the following extensions: .mpg, 
.mpeg, .mov, .avi, .bmp, .tiff, .pic, .rtf, .doc, .xls, .pdf, .txt, .zip, .ppt 
(ms power point), .jpg, .jpeg, .gif, .htm, .html, .hqx (for macs).  

 

Step 3: Whether you’ve already uploaded the file or image or not, start the 
link process by entering Link Text for the file. This is the text that 
students will click to get to the file or image. For images, you will be 
asked to enter Descriptive Text for the image file. 

 
Tip: Link text is text students click to open the file or web site to which you 
are linking. Descriptive text will appear when students place their cursor 
over an image. This text describes the image for users who cannot view the 
image.  
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Step 4: If you chose "upload new file," you will be asked where you would 
like to upload the file. If you've created specific file folders for your 
course with the Manage Files option on the Course Home Page, 
your file structure appears on the left. If not, you can create a new 
file folder with the Link Wizard. See the Help topic Managing Files 
for more information. If you haven't set up a course file structure, 
your file will be uploaded to the default (main) course folder, or you 
can create a new folder at this point. 

Tip:  If you're linking to a streaming media file (real audio (.ra), real video 
(.rm), or slideshow (.rpm)), make sure you select the Streaming 
Media folder as the destination folder for the uploaded file. All 
streaming media files must reside in the Streaming Media folder for 
your course. If you choose the Streaming Media folder, the standard 
streaming media options will appear. Refer to the Help topic 
Managing Files for more information. 

Step 5: Using either the folder structure or the Browse feature, find the file 
you wish to link to in the Select File box, then click Add Link.  

 
To add a link to a website:  

Step 1: Click the Link button on the Visual Editor toolbar. The Link Wizard 
opens.  

Step 2: From the drop-down list, select Link to a Website. 

Step 3: Enter the Link Text. This is the text that students will click to open 
the website. 

Step 4: Enter the URL or website address in the textbox provided. It’s a 
good idea to copy and paste the address into the Link Wizard to 
avoid any typos in the URL.  

Step 5: Click Add Link.  

 
To add a link to an area within your course:  

Step 1: Click the Link button on the Visual Editor toolbar. The Link Wizard 
opens.  

Step 2: From the drop-down list, select Link to Area in Course. 

Step 3: Select either Course Content or Course Tools. Course content 
items are content items you’ve created like Word documents, 
exams, threaded discussions, etc. Course tools are generally 
located on the tabs at the top of your course (Email, Chat, Dropbox, 
etc.) 

Step 4: If you selected Course Content, use the drop-boxes to select an 
area and a specific content item in your course to link to. If you 
selected Course Tools, use the drop-box to select the appropriate 
course tool. 

Step 5: Enter Link Text for the link. This is the text that students will click to 
go to the specific area of the course. 
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Step 6: Click Add Link.  

 

Using the Math Equation Editor 
You can use the Equation Editor to build and edit complex mathematical equations within your 
course. Accessed from the Visual Editor (or Text Editor), the Equation Editor is available 
anywhere in your course where the Visual Editor appears. The Equation Editor includes a 
comprehensive set of mathematical symbols and templates that are easy to access from pull-
down palettes. You can use the tool to build, demonstrate, and apply mathematic notations, 
formulas, and sample equations throughout your course.  
 
Any time you create a new equation it will be saved in a list of equations for that course. As a 
result, you can create equations and actually insert them into your course content at the time you 
create them, or you can simply create and "store" equations in a list to use later in your course. 
You can create an equation once and "insert" it into your course as many times as you'd like. You 
can also edit an equation from the Equation List and then choose to update the equation in all 
instances of the course. 
 
If you have a software application with which you currently generate MathML code, you can copy 
and paste existing MathML code into the Equation Editor as well.  
 
 
To add or create a new equation: 

Step 1: Position you cursor inside the Visual Editor in the exact place where 
you want to insert or add the equation. 

Note: If you are using a Mac or Netscape, the equation will be appended 
to the end of your content rather than added "in-line." To move the 
equation, you’ll need to cut or copy the HTML code for the equation 
in the Text Editor, beginning with the <img> tag, and paste the code 
or tag to the new location. 

Step 2: Open the Equation Editor by clicking on the Equation Editor button 
in the Visual/Text Editor. In the Visual Editor, the Equation Editor 
button looks like this: 
 

 
 
The Equation Editor window opens. Any equations you've already 
created in the course are listed alphabetically by equation title. 

Step 3: Click the Create New Equation link. 

Step 4: Enter a unique title for the new equation (for example, "Quadratic 
Formula" or "Unit 4 Equation" or "Section 3 Quiz Question #9"). 
Remember that all equations in your course are listed alphabetically 
by equation title in the Equation List, so you'll want to name the 
equation something that you'll remember and that's easy to locate 
or identify. You must enter a title. 

Step 5: Create your equation using the toolbar buttons and pull-down 
options. 
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Note: To create your equation, single click on a button to display a pull-
down palette of additional functions. From the palette, select the 
operation or symbol you want to add. The symbol or function will 
appear in the Equation Editor. If you're creating an equation, use 
the TAB key or the arrow keys to move from one part of the 
equation to the next. When you've finished creating the equation, 
press ENTER to "set" the equation.  
 
For specific help, tips, and shortcuts on how to create equations 
with the Equation Editor, click the Help button (?) on the Equation 
Editor toolbar. 

Step 6: When you're finished creating your equation, you have three 
options:  

• Save & Insert. Select this option to insert (or append) the 
equation into the current text area and save the equation to 
the Equation List.  

• Save. Select this option to save the equation to the 
Equation List without inserting it in the current text area.  

• Cancel. Select this option to return to the Equation List 
without saving any of your work 

 

Note: When you insert an equation into the Visual Editor, you need to 
make sure you click Save Changes (in the Visual Editor). If you 
forget to save changes to the Visual Editor, the equation is still 
saved in your Equation List, but the equation does not appear in the 
Visual Editor and you’ll need to re-insert it. 

 
If you have a software application with which you currently generate MathML code, you can copy 
and paste existing MathML code into the Equation Editor (saving you from having to re-create 
equations you've already built). 
 
To paste existing MathML equations into the Equation Editor, click the Show MathML link at the 
bottom of the Equation Editor window. Paste your existing MathML code into the editing field that 
appears. Note that you can "tweak" the code you pasted in with this editor. You can also tweak or 
modify equations that are currently displaying in the Equation Editor window, whether you pasted 
them in or not. When you're finished, click the Done button to save your changes.  
 
 
To edit an existing equation: 

Step 1: Open the Equation Editor by clicking on the Equation Editor button 
in the Visual/Text Editor.

Step 2: In the Equation List, click the "+" sign next to the title of the equation 
you want to edit. This will "expand" the equation.

Step 3: Click Edit. The equation displays in the Equation Editor editing 
area. 

Step 4: Make any changes to the equation as needed. 
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Step 5: When you're finished editing the equation, you have four options:  

• Replace & Insert. Select this option to save the edited 
equation to the Equation List and to overwrite the equation 
EVERYWHERE it's been used or inserted in the course.  

• Replace. Select this option to save the edited equation to 
the Equation List without inserting it into the current text 
area. This option also replaces the edited equation 
EVERYWHERE it appears in the course; that is, the 
Replace option will overwrite all instances of this equation.  

• Save as New. Select this option to save the edited equation 
to the Equation List as a new equation with a new title (you 
must rename the equation). If you select Save as New, you 
will need to return to the Equation List and insert the 
equation into the Visual or Text editor.  

• Cancel. Select this option to return to the Equation List 
without saving any of your work. 

 
To insert an existing equation: 

Step 1: Position you cursor inside the Visual Editor in the exact place where 
you want to insert or add the equation.

Note: If you are using a Mac or Netscape, the equation will be appended 
to the end of your content rather than added "in-line."

Step 2: Open the Equation Editor by clicking on the Equation Editor button 
in the Visual/Text Editor. 

Step 3: In the Equation List, click the "+" sign next to the title of the equation 
you want to insert. This will "expand" the equation. 

Step 4: Click Insert. The equation is inserted at the current cursor position. 

 
To delete an existing equation: 

Step 1: Locate the equation you'd like to delete within your course and click 
the Author tab. You should see the equation within the Visual 
Editor (or Text Editor).

Step 2: Select the equation in the Visual Editor (or the equation's <img> tag 
in the Text Editor) with your cursor and hit the Delete key. The 
current instance of the equation is deleted. 

Note:  The equation is NOT deleted from the Equation List (you can still 
select the equation and insert it in other places in the course). Nor is 
the equation deleted anywhere else in the course where you've 
inserted it. The only way you can delete an equation from your 
Equation List is if the equation is no longer used ANYWHERE in the 
course. Expand the equation in the Equation List and click Delete to 
delete the equation from the list. 
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Accessibility Requirements 
If you're creating a course that must meet accessibility requirements, please read the 
following information carefully. If you're not sure if your course must meet accessibility 
standards, please refer to your organization's policies for web accessibility. 
 
U.S. Federal Section 508 identifies specific development standards that ensure electronic 
information transmitted over the world wide web is accessible to people with disabilities. Although 
not all schools and institutions require their online courses to meet Section 508 requirements, if 
an online course claims to be Section 508 compliant, the content and functionality of the course 
must be available to all persons regardless of disability. 
 
If you ARE authoring a course that must be Section 508 compliant, you'll need to take care that 
all content in your course meets the standards set forth in Section 508. The standards are 
summarized in the table below. They are also available online at: 
 
 
http://www.access-board.gov/sec508/guide/1194.22.htm 
 
 

Electronic and Information Technology Accessibility Standards (EITAS) 
 (Section 1194.22) 

Paragraph Requirement Text Additional 
Information

(a) A text equivalent for every non-text element shall be provided 
(e.g., via "alt", "longdesc", or in element content). 

More info 

(b) Equivalent alternatives for any multimedia presentation shall be 
synchronized with the presentation. 

More info 

(c) Web pages shall be designed so that all information conveyed 
with color is also available without color, for example from 
context or markup. 

More info 

(d) Documents shall be organized so they are readable without 
requiring an associated style sheet. 

More info 

(e) Redundant text links shall be provided for each active region of a 
server-side image map. 

More info 

(f) Client-side image maps shall be provided instead of server-
sid5.2e image maps except where the regions cannot be defined 
with an available geometric shape. 

More info 

(g) Row and column headers shall be identified for data tables. More info 
(h) Markup shall be used to associate data cells and header cells for 

data tables that have two or more logical levels of row or column 
headers. 

More info 

(i) Frames shall be titled with text that facilitates frame identification 
and navigation. 

More info 

(j) Pages shall be designed to avoid causing the screen to flicker 
with a frequency greater than 2 Hz and lower than 55 Hz. 

More info 

(k) A text-only page, with equivalent information or functionality, shall 
be provided to make a web site comply with the provisions of this 
part, when compliance cannot be accomplished in any other way. 
The content of the text-only page shall be updated whenever the 
primary page changes. 

More info 

(l) When pages utilize scripting languages to display content, or to 
create interface elements, the information provided by the script 
shall be identified with functional text that can be read by 
assistive technology. 

More info 



Copyright © 2008 eCollege 
Page 148 

(m) When a web page requires that an applet, plug-in or other 
application be present on the client system to interpret page 
content, the page must provide a link to a plug-in or applet that 
complies with §1194.21(a) through (l). 

More info 

(n) When electronic forms are designed to be completed on-line, the 
form shall allow people using assistive technology to access the 
information, field elements, and functionality required for 
completion and submission of the form, including all directions 
and cues. 

More info 

(o) A method shall be provided that permits users to skip repetitive 
navigation links. 

More info 

(p) When a timed response is required, the user shall be alerted and 
given sufficient time to indicate more time is required. 

More info 

 
 
Additional information about making specific course content items Section 508 compliant is 
available in the Help section of the individual content item. 
 
If you'd like more specific information and/or help with developing a universally accessible online 
course, there are several ways eCollege can help. First, eCollege offers course development 
services that can assist you in creating a universally accessible online course. Contact your 
eCollege Client Services representative for more information. Second, the eTeaching Institute at 
eCollege offers a one-week online course called EDU 104: Designing a Universally Acceptable 
Course which will help you learn what an accessible course is and how you can ensure that your 
course is accessibility-compliant. For additional information, please visit 
http:\\www.eTeaching.ecollege.com or contact us via email at:  inquiry@eteaching.ecollege.com. 
 
 
 

Using the HTML Guide 
Although HTML experience is not necessary to create your course, some general HTML 
background may be helpful. We've included an HTML Reference Guide here to help you with 
basic HTML code. There are also numerous web sites that can provide additional information on 
using HTML.  
 
HTML Reference Guide 
HTML is made up of beginning and ending tags. Generally, you need to start and end every tag. 
The ending tag will look just like the beginning tag, with an added forward slash "/". You can see 
examples below:  
 

Purpose Code Coded Document Example Actual Document 
Example 

Line Break <BR> 
A break will simply break your  
<BR>  
text and continue on the next line. 

A break will simply 
break your  
text and continue 
on the next line. 

Paragraph 
Break <P>  

A paragraph break will leave 
<P> 
an empty row in between the text. 

A paragraph break 
will leave 
  
an empty row in 
between text. 

Horizontal 
Ruling <HR> This will draw a  

<HR>  
This will draw a  
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line across a page. line across a page.

Underlining <U> <U>This text will be underlined. 
</U>

This text will be 
underlined.  

Bolding <B> <STRONG>This text will be 
bold.</STRONG>

This text will be 
bold. 

Italicizing <I> <EM>This text will be 
italicized.</EM>

This text will be 
italicized. 

Centering <CENTER> <CENTER>Hello</CENTER> Hello 

Divisions 

<Div align="left">
<Div 
align="center"> 
<Div 
align="right">  

<Div align="left">Hello</Div> 
<Div align="center">Hello</Div> 
<Div align="right">Hello</Div> 

Hello 
Hello 
Hello 

*Ordered 
Listing <OL> 

<OL> 
<LI>Clerks 
<LI>Olaf 
<LI>Berzerker 
</OL>

Clerks  
Olaf  
Berzerker  

*Unordered 
Listing <UL> 

<UL> 
<LI>Clerks 
<LI>Olaf 
<LI>Berzerker 
</UL>

Clerks  
Olaf  
Berzerker  

*Font Sizing <FONT 
SIZE="+2"> <FONT SIZE="+2">Hello</FONT> Hello 

*Font 
Coloring 

<FONT 
COLOR="RED">

<FONT 
COLOR="RED">Hello</FONT> Hello 

Comment 
Tags <!--  --> <!-- This text won't show up -->  

 
 
Ordered lists and unordered lists  
The <LI> tag should be placed where a number belongs (ordered list) or a bullet belongs 
(unordered list).  
You can identify what kind of numbering, or bullets to use by using an "attribute" within the list 
tag. There are two attributes that will work with lists:  
TYPE: <ul type="..."> 
Values may include -a,A,i,I,1 (ordered lists), and - disc, square, circle (unordered lists)  
START (only for ordered lists): <ol start="..."> 
Values may include - 1,2,3,4... (always use numbers)  
 
Font sizing and coloring   
The size and color can be varied by changing the number/color within the quotation marks. It is 
best to look up the HEX triplet (six digit number) for a color you need. 
 
 

FAQ’s 
Because the idea of creating an online course may be new to you, we've included a list of 
Frequently Asked Questions. Check the list below to see if your questions have already been 
asked and answered.  
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What Are the Four Greatest Advantages of Online Courses? 
Online learners have the ability to learn at anytime, from anywhere — time and place constraints 
have been eliminated.  
 
Online learning is student-centered. The instructor is “the guide on the side”, not “the sage on the 
stage”. A particular student cannot monopolize all of the instructor’s time, nor can a student seek 
to hide in back of the class. Because most of the learning is done in an asynchronous setting, the 
learner has time to compose his/her thoughts prior to submitting them to the class.  
 
Online education makes education available to a greater number of potential students such as 
students who work full-time, people who travel, parents and urban/rural dwellers who desire to 
eliminate the commute.  
 
Online courses can incorporate the latest in available technology such text, audio, video, slides, 
graphics, images, threaded discussions, an online library, a Webliography, real-time chat room, 
email, exercises, online testing, and more. Online education uses numerous learning tools, 
thereby appealing to different learning styles. 
 
What Are the Four Most Significant Challenges, Limitations, or Shortcomings of 
Online Education? 
Being in a new environment, students and faculty are unfamiliar with the medium. They have 
been educated using the traditional, face-to-face system and may find the new environment 
difficult at first because of the lack of interpersonal communication.  
 
Online learning is not easy. Technology may be intimidating to some people. The Internet 
sometimes does strange things. An Internet connection can “go down” (be broken off) for 
unspecified and unknown reasons. A computer can be a very rewarding or a very frustrating 
experience. Some people are not technical by nature nor do they have the inclination or the time 
to educate themselves with or without outside assistance.  
 
Sometimes asynchronous (delayed) communication is not more valuable than immediate 
correspondence. Firstly, it is troublesome to wait for a response from a professor when the 
student desires and immediate answer. Secondly, communication can be more useful to the 
professor when the students reply spontaneously.  
 
Online learning is not appropriate for everyone. Some people need the traditional classroom 
environment with face-to-face interaction and immediate feedback.  
What Are the Best Current Solutions to These Four Challenges, Limitations, or 
Shortcomings? 
To overcome the new environment users need to spend time in the new environment. Yes, there 
is no face-to-face communication; but there are other numerous types of interaction, both 
synchronous and asynchronous, that are available to fill the void. Some examples are 
discussions, real-time chat rooms, email, message center, threaded discussions, and 
Webliography (a combination of the worldwide web and a bibliography).  
 
The online environment must be developed so that technology is not a factor. Students take 
courses to learn the course material, not to learn about technology. Therefore, the delivery 
system needs to have a similar look and feel for all courses, helping both students and instructors 
feel comfortable. Students will only have to learn online once and subsequent courses will 
function the same. There has been careful thought to make sites as intuitive as possible with 
learning tools and features easy to identify and use.  
 
To overcome the challenge of the lack of face-to-face communication, two things must be done. 
First, while online education is available at 'any time, any place' to students, instructors MUST 
check their email at least three times a week and return student’s emails within a specified 
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amount of time. Second, when 'off-the-cuff' communication is required, outside media can be 
used (i.e. telephone). Also, when technology improves, real-time audio chats over 28.8 modems 
will be available.  
 
Online education will not replace the classroom. The classroom will always survive. Online 
education is meant to expand the educational opportunities to all students and to students who 
might not otherwise have the chance to take a course or degree in a traditional setting. 
 
What is the turn around time on helpdesk responses for students and faculty? 
Our helpdesk is now available by phone 24 hours a day, 7 days a week. The helpdesk can also 
be reached by email. Email inquiries will be responded to within 3-4 hours during business hours, 
and always within 24 hours. Average response is less than 4 hours. 
 
What is the estimated time that a faculty member is online teaching their 
students? 
There is no standard answer for this question. The amount of time depends on the instructor’s 
teaching style, technical skills, the subject matter, if the course has already been developed for a 
face-to-face environment and other factors. 
 
Have you lost any grades/exams/course material? 
No system is infallible. As a matter of course, the EP should keep a current back up of all 
materials or individual professor in the event of some unforeseeable catastrophe should occur. 
eCollege.com backs-up the system, as well as your course content and student enrollments, 
automatically every night onto a tape. There is a Sunday tape, Monday tape, Tuesday tape, etc., 
so that our back-ups go for seven days (but not longer than seven days in most instances). 
 
How often is the system down? 
Almost never. Our system is up over 99.7% of the time. Last year, we had less than 20 hours of 
total down time. When the system does go down, several people at eCollege.com are 
automatically notified regardless of time of day, ensuring we are immediately working on the 
problem. Our average down time is less than ten minutes per occurrence. 
 
What special rules apply to the copyright of material delivered over the web?  
eCollege.com does not help in obtaining copyrights and permissions, and we cannot be held 
liable for copyright infringements. We advise our partners that the online classroom is very similar 
to the traditional classroom and they should follow the same permission policies. The online 
classroom is a closed environment (meaning there is a limited and controlled number of users 
and it is password protected). We believe that the Fair Use for Educational Purposes doctrine 
applies. The EP may want to consult with their legal department and/or library service 
department. 
 
Do students have to sit down at their computers at the same time every day? 
Not really. Inherent course flexibility gives students the ability to determine when it is best for 
them to go online. This helps minimize the time actually spent online. Occasionally, classes are 
held at specific times (synchronously), but usually students study on their own schedule 
(asynchronously). 
 
 
 
 
 
 
 




